
1

User Guide
BrightAuthor Release 3.7 本書で述べられている製品やサービスは、2014年3月現在のものであり、改善のため事
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BrightAuthorとは

この度はBrightSign LLCのデジタルサイネージ向けメディアプレイヤー”BrightSign”をご購入いただきありがとうございました。本書で
はBrightSignの使い方をご紹介します。

CHAPTER 1 はじめに

BrightAuthorを使用することによりBrightSignで表示させるプレゼンテーションを簡単に作成することができます。BrightSignは下記コンテンツ
を表示させることができます。※ Dynamic Playlist、BrightSign Network (Networked with the BrightSign Network)につきましては、お問い合
わせください。

・ 静止画、動画 、オーディオ、RSS、テキスト、時間 / 日時、HDMI入力(XD1230のみ対応)

BrightSignファームウェアアップデート、BrightAuthorアップデート

ご購入いただきましたBrightSign本体のファームウェア、BrightAuthorのバージョンは最新ではない場合があります。BrightSignをモニターと
接続しファームウェアのバージョンが4.7.112未満（XD230、XD1030、XD1230）、4.7.112未満（HD120、HD220、HD1020）、3.10.57未満
（HD110、HD210、HD410、HD810、HD1010）の場合は下記手順でファームウェアをアップデートしてください。また最新のファームウェア、
BrightAuthorは下記よりダウンロードできます。

http://support.brightsign.biz/entries/314637-brightsign-downloads

＊BrightAuthorを更新するとファームウェアのアップデートが必要です。

ファームウェアのアップデート手順

a 付属CD-ROMに収録されている、Firmwareフォルダーより適したファームウェアを選択してSDカードに保存します。
b BrightSignをディスプレイに繋ぎ、SDカードを挿します。
c BrightSignに電源を入れます。
（電源のON/OFFスイッチはありません。ACアダプタをBrightSign本体に繋ぎます)

d BrightSignのUpdランプが点滅し、自動的にアップデートが始まります。
e アップデートが終わると画面にBrightSignのロゴとファームウェアバージョンが表示されます。
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レイアウトのタイプ
・ フルスクリーン ： 全画面にコンテンツを表示

・ マルチスクリーン ：ゾーン機能（画面分割）を使用し、ディスプレイに1つの動画と複数の静止画、テキスト、時間を表示

Step 1：ご用意いただくハードウェア

ご利用のためには、BrightSign本体の他に、別途下記をご用意ください。

・ Windows PC
BrightAuthorをインストールするために必要になります。

・ SDメモリーカード （SDHC、SDXC、Class 6以上推奨）
コンテンツを保存します。BrightSignに接続してコンテンツの再生を行います。
＊ BS/HD110、BS/HD210、BS/HD410、BS/HD810、BS/HD1010はSDXCには対応しておりません。
＊ BS/XDシリーズで複数の動画を再生するには、Class 10以上が推奨です。

・ ディスプレイ ・ ディスプレイケーブル
VGA、HDMI、コンポーネント（HD810、HD1010のみ対応）入力に対応したディスプレイとディスプレイケーブル。
＊ BS/XD230、BS/XD1030、BS/XD1230、BS/HD120、BS/HD220、BS/HD1020は別途VGA-コンポーネント変換ケーブルが必要です。
（接続方法によって出力可能な解像度が異なります）

・ SDカードリーダー
SDカードにBrightAuthorで作成したコンテンツを書き出す際に使用します。

・ Webサーバー（Webフォルダー）
ネットワークを使用したコンテンツの更新、スケジュール再生の際にBrightSignがWebフォルダー内の情報をダウンロードします。
＊XD230、XD1030、XD1230、HD220、HD1020、HD210、HD1010でSimple File Networking機能を利用する場合のみ。
＊Webサーバーはお客様でご用意して頂く必要があります。

BrightAuthorでは2つのタイプのプレゼンテーションを作成できます。

・ Non-Interactive ： 連続した静止画のスライドショーまたは動画再生。
全てのBrightSignモデルで対応

・ Interactive ： ボタンやタッチスクリーン、キーボードなど、様々な入力デバイスと接続しBrightSignを制御します。
＊モデルにより使用できる機能が異なります。

プレゼンテーションのタイプ
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Windows PC 最小システム条件

・ 2.3GHz CPU
・ 2GB RAM （推奨 4GB)
・ 100MB以上の空きのあるハードディスク
・ OS
・ Windows Vista 32 or 64 bit
・ Windows 7 32 or 64 bit 

BrightSign ファームウェアバージョン 4.7.112以上

・対応機種

・ BS/XD230 ・ BS/XD1030 ・ BS/XD1230

BrightSign ファームウェアバージョン 4.7.112以上

・対応機種

・ BS/HD120 ・ BS/HD220 ・ BS/HD1020

BrightSign ファームウェアバージョン 3.10.57以上

・対応機種

・ BS/HD110 ・ BS/HD210 ・ BS/HD410 ・ BS/HD810 ・ BS/HD1010

接続ディスプレイ

・ VGA
・ コンポーネント（対応機種：BS/HD810 、BS/HD1010）
＊ BS/XD230、BS/XD1030、BS/XD1230、BS/HD120、BS/HD220、BS/HD1020は別途VGA-コンポーネント変換ケーブルが必要です。
・ HDMI
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ストレージメディア

・ USBフラッシュドライブ（対応機種：BS/XD1030、BS/XD1230、BS/HD1020、BS/HD810、BS/HD1010)
・ SDカード
・ SDHCカード
・ SDXCカード （対応機種：BS/XD230、BS/XD1030、BS/XD1230、BS/HD120、BS/HD220、BS/HD1020)
Note：SD、SDHC、SDXCカードはFAT32でフォーマットする必要があります。

SDカードリーダー・ライター

・ PCで作成したプレゼンテーションファイルをSDカードへ保存する際に使用します。

入力デバイス（対応機種：BS/XD1030、BS/XD1230、BS/HD120、BS/HD1020、BS/HD410、BS/HD810、BS/HD1010）

・ 標準的なHID（ヒューマンインターフェースデバイス）をサポートするタッチ・コントローラ。
サポートされているタッチ・コントローラにつきましては、下記のご参照をお願いします。
（対応機種：BS/XD1030、BS/XD1230、BS/HD1020、BS/HD810、BS/HD1010) 
http://support.brightsign.biz/entries/262256-whattouchscreens-can-i-use-with-the-brightsign
・ USBキーボード（対応機種：BS/XD1030、BS/XD1230、BS/HD1020、BS/HD810、BS/HD1010)
・ USBマウス、トラックボール（対応機種：BS/XD1030、BS/XD1230、BS/HD1020、BS/HD810、BS/HD1010)
・ シリアル機器（対応機種：BS/XD1030、BS/XD1230、BS/HD1020、BS/HD410、BS/HD810、BS/HD1010)
・ GPIO機器（対応機種：BS/XD1030、BS/XD1230、BS/HD120、BS/HD1020、BS/HD410、BS/HD810、BS/HD1010)
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Step 2：BrightAuthorのインストール

1. 付属のCDをCD-ROMドライブに挿入します。
CDがマウントされたら「マイコンピュータ」からCD-ROMドライブを開きます。
CD-ROM内の「BrightAuthor_Setup」フォルダー内に収録されている「Setup3.7.0.37.exe」ファイルをダブルクリックし
インストールを開始します。

2. BrightAuthor ‒ InstallShield Wizardが表示されたら、「Next」をクリックしてインストールを進めます。
BrightAuthorのインストールが終了するとInstallShield Wizard Completedと表示されるのでFinishをクリックして終了します。

NOTE：BrightAuthorを使用するには最新のMicrosoft .Net Frameworkが必要です。

Step 3：BrightAuthorの起動

1. デスクトップ上にあるBrightAuthorアイコンをダブルクリックします。

2. BrightSign Networkアカウントを要求される場合があります。OKを押して次に進みます。 BrightSign Networkは標準では利用でき
ません。BrightSign Networkをご利用になる場合は、お問い合わせください。
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Step 4：BrightAuthorのサポートコンテンツ

対応状況が変更になる場合があります。最新の対応情報は下記URLよりご確認ください。
・Video files
http://support.brightsign.biz/entries/143091-what-video-formats-and-codecs-does-the-brightsign-support

・Video Quality Tech note
http://www.brightsign.biz/documents/HDCompact_VideoQualityTechnote.pdf

・Audio files
http://support.brightsign.biz/entries/143768-what-audio-formats-does-the-brightsign-support

・ Video files

・ MPEG-2、MPEG-1、H.264 (MPEG-4 , Part 10)
・ .TS , .MPG , .VOB , .MOV , .MP4
・ Additionally Supported .WMV, exported from Powerpoint (.WMV, video only) 

・ WMA audio is not supported

・ MPEG-2 Program and Transport streams 
・ H.264 Transport and Program Streams (program streams (mov & mp4) require firmware 3.5) 
・ AAC audio supported with h.264 files
・ Main or High Profile up to level 4.1
・ CBR audio (vbr not supported)

・ MPEG-1 System Streams only (elementary streams are not supported)
・ Maximum bit rate recommended is 25Mbps; see Video Quality Tech note for details on higher bit rate support 
・ Maximum video resolution supported is 1920x1080p (progressive) 
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・ Audio files

・ AAC audio in H.264 Video (CBR only, NO VBR support) 
・ MP3 audio files as stereo or mono at a 48KHZ sampling rate (MPEG1/MPEG2 Video)
・ Dolby Digital (AC3) 5.1 audio in a video (pass-through over HDMI) (MPEG2 Video) 

NOTE：BrightSigns do not decode surround sound audio, but pass it through over HDMI 

・ Image files

・ BMP - 8, 16, 24, and 32-bit 
・ PNG and JPEG formats 
・ Maximum image resolution supported is 1920x1080 

NOTE：CMYK JPEGS not supported 

Step 5：プレゼンテーションの作成

これまでのステップでBrightAuthorを使用しプレゼンテーションを作成する準備が出来ました。
プレゼンテーションの作成方法については、CHAPTER 2 Setting Up Unitsをご参照ください。

Step 6：プレゼンテーションのPublish

作成したプレゼンテーションをBrightSignで再生するために、BrightAuthorからPublishする必要があります。
CHAPTER6 プレゼンテーションのPublishをご参照ください。
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CHAPTER 2 Setting Up Units

BrightAuthorでプレゼンテーションを作成する前に、BrightSign本体の設定をする必要があります。

・ BrightSign Network ： BrightSign社の有料のサービスです。BrightSign Networkを使用することで、リモートでコンテンツの配信、グ
ループの割り当て、BrightSignのステータスを確認できるクラウドベースのサービスです。

・ Local Network ： ローカルネットワーク経由でBrightAuthorがインストールされているPCからBrightSign本体にプレゼンテーションを
Publishすることができます。Webサーバーを必要とせず、簡単にプレゼンテーションの変更を行えます。

・ Simple File Network ： ネットワーク経由でコンテンツを更新することができます。BrightSignは指定されたWebフォルダーを定期的に
確認し更新します。

・ Standalone ： プレゼンテーションの更新の度に、ストレージ(SDカード、USBフラッシュドライブ)を更新する必要があります。時間の
設定やIPアドレスを登録しない場合はStandaloneの設定をする必要はありません。

プレゼンテーションのPublish方法につきましてはCHAPTER6 プレゼンテーションのPublishをご参照ください。
＊Networked with the BrightSign Networkをご利用になる場合は、お問い合わせください。

Local Networkの設定

Local NetworkでPublishを選択すると、ローカルネットワーク経由で直接BrightSign本体にプレゼンテーションをPublishすることができ
ます。
プレゼンテーションの保存方法につきましては、 CHAPTER6 プレゼンテーションのPublish Publishing with Local Networkingをご参
照ください。

BrightAuthorの初期設定では、Local Networkのタブが表示されません。
メニューバーから、Edit ＞ Preferences ＞ Networkingを選択し、Enable BrightSign Local Networkingにチェックを入れます。
＊Enable Bonjourにチェックを入れるとPublish画面で自動的にローカルネットワーク上にあるBrightSignを認識します。BonjourはApple
社のプロトコルです。(iTunesをインストールすることでBonjourも同時にインストールされます)
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1 メニューバーから、Tools > Setup BrightSign Unitを選択すると、BrightSign Unit Setupウィンドウが開きます。

2 Name Specification ：
a NameとDescription欄に任意の文字を入力します。
b Customization
・Use name only ： Name Specification で設定した名前のみ表示
・Append unit ID ： Name Specification で設定した名前と、BrightSign本体のIDを表示

3 Network Properties ：
a Enable Wireless ： BrightSignのWirelessモデルを使用する場合にチェックを入れます。
＊BrightSignのWirelessモデルは取扱がありません。

b Time zone ： タイムゾーンの選択
c Time server ： タイムサーバーの設定

4 Advanced Network Setup ：
a Unit Configuration ：プロキシサーバーを使用する場合はチェックを入れ、アドレスとポート番号を入力します。
b Wired ： BrightSign本体にIP addressを設定します。Wiredタブをクリックし、IP addressを自動設定するにはObtain an IP address
automatically、任意に設定するにはUse the following IP addressにチェックを入れます。
＊Data Types EnabledはWirelessを選択したときのみ選択できます。

c Diagnostics ： 最初の起動時にネットワークの診断を行います。
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5 ファームウェアを更新する場合はSpecify Firmware Updateをクリックし、ファームウェアを選択します。
Firmware Updateウィンドウが表示されるので、ファームウェアを選択します。

6 Unit Configuration ：
a Enable diagnostic web server ：diagnosticを有効にします。パスワードを設定することができます。
b Enable local web server ： チェックを入れるとパスワード設定することができます。

7 Networked with Local File Networkingにチェックを入れます。

8 Logging ： Loggingを有効にするにはチェックボックスのいずれかにチェックを入れ、アップロード設定を指定します。

a Enable playback logging ： プレイリストが再生された際にログを作成します。
b Enable event logging ： イベントのログを作成します。
c Enable state logging ：現在と最後のstate names 、timestampsやmediaタイプのログを作成します。
d Enable diagnostic logging ： timestamps、firmware、Scriptバージョンや現在のプレゼンテーションのログを作成します。

＊RF Channel Scan Data (optional)は国内では利用できません。



16

9 Setup BrightSign Unitの保存
a Create Setup Filesを選択します。
b フォルダー、SDカード、USBフラッシュドライブ（BS/XD1030、BS/XD1230、BS/HD1020、BS/HD810、BS/HD1010）のいずれか
を選択します。

c 9-b 選択後OKをクリックします。
d 電源アダプタを抜いて、BrightSign本体の電源をオフにします。BrightSign本体に9-c で保存したSDカードまたはUSBフラッ
シュドライブを接続します。

e 電源アダプタを接続して、BrightSign本体の電源をオンにします。

＊SDカードまたはUSBフラッシュドライブはBrightSign本体から抜かないでください。BrightSign本体の内部メモリーにSetup
BrightSign Unitで設定したファイルを記憶させることができません。
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Simple File Networkの設定

Simple File NetworkingでPublishを選択すると、ネットワーク経由でコンテンツを更新することができます。BrightSignは指定されたWeb
フォルダーを定期的に確認し更新します。
プレゼンテーションの詳細な保存方法については、 CHAPTER6 プレゼンテーションのPublish Publishing with Simple File Networking
をご参照ください。

1 メニューバーから、Tools > Setup BrightSign Unitを選択すると、BrightSign Unit Setupウィンドウが開きます。

2 Name Specification ：
a NameとDescription欄に任意の文字を入力します。
b Customization
・Use name only ： Name Specification で設定した名前のみ表示
・Append unit ID ： Name Specification で設定した名前と、BrightSign本体のIDを表示

3 Network Properties ：
a Enable Wireless ： BrightSignのWirelessモデルを使用する場合にチェックを入れます。
＊BrightSignのWirelessモデルは取扱がありません。

b Time zone ： タイムゾーンの選択
c Time server ： タイムサーバーの設定

4 Advanced Network Setup ：
a Unit Configuration
・ Use proxy ：プロキシサーバーを使用する場合はチェックを入れ、アドレスとポート番号を入力します。
・ Limit content downloads ：チェックを入れると、ダウンロードを開始する時間とダウンロードを終了する時間を
設定できます。

b Wired
・ Connection Settings ： BrightSign本体にIP addressを設定します。IP addressを自動設定するにはObtain an IP address
automatically、任意に設定するにはUse the following IP addressにチェックを入れます。

＊Data Types EnabledはWirelessを選択したときのみ選択できます。
・ Rate Limit Network Download Traffic ： コンテンツをダウンロードする際に、容量を制限できます。

c Diagnostics ： 最初の起動時にネットワークの診断を行います。
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5 ファームウェアを更新する場合はSpecify Firmware Updateをクリックし、ファームウェアを選択します。
Firmware Updateウィンドウが表示されるので、ファームウェアを選択します。

6 Unit Configuration ：
a Enable diagnostic web server ：diagnosticを有効にします。パスワードを設定することができます。
b Enable local web server ： チェックを入れるとパスワードを設定することができます。
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7 Networked with Simple File Networkingにチェックを入れます。
a URL for web folder ： BrightSign本体がプレゼンテーションをダウンロードするWebフォルダーを設定します。
＊上記で設定するWebフォルダーのURLはプレゼンテーションをPublishするときに設定したWebフォルダーのURLと同一であ
る必要があります。プレゼンテーションの詳細な保存方法についてはCHAPTER6 プレゼンテーションのPublish Publishing 
with Simple File Networkingをご参照ください。

b Content Check Frequency ：サーバーにコンテンツの更新を確認する頻度を設定します。
c Simple File Networking Authentication ：Webサーバーでセキュリティーを設定している場合は、この項目にチェックを入れます。
・Enable basic authentication ：Basic認証を行う場合はチェックを入れます。

8 Logging ： Loggingを有効にするにはチェックボックスのいずれかにチェックを入れ、アップロード設定を指定します。
a Enable playback logging ： プレイリストが再生された際にログを作成します。
b Enable event logging ： イベントのログを作成します。
c Enable state logging ： 現在と最後のstate names 、timestampsやmediaタイプのログを作成します。
d Enable diagnostic logging ： timestamps、firmware、Scriptバージョンや現在のプレゼンテーションのログを作成します。
e Upload logs ：
・ On startup ： スタートする度にログファイルをアップロードします。
・ At specific time each day ： 指定された時間に毎日ログファイルをアップロードします。
・ Relative URL for log handler ： ログファイルをアップロードする場所を入力します。

＊RF Channel Scan Data (optional)は国内では利用できません。

9 Setup BrightSign Unitの保存
a Create Setup Filesを選択します。
b フォルダー、SDカード、USBフラッシュドライブ（BS/XD1030、BS/XD1230、BS/HD1020、BS/HD810、BS/HD1010）のいずれか
を選択します。

c 9-b 選択後OKをクリックします。
d 電源アダプタを抜いて、BrightSign本体の電源をオフにします。BrightSign本体に9-c で保存したSDカードまたはUSBフラッ
シュドライブを接続します。

e 電源アダプタを接続して、BrightSign本体の電源をオンにします。
＊SDカードまたはUSBフラッシュドライブはBrightSign本体から抜かないでください。BrightSign本体の内部メモリーに
Setup BrightSign Unitで設定したファイルを記憶させることができません。
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Standaloneの設定

Standaloneで使用する場合はプレゼンテーションの更新の度に、ストレージ（SDカード、USBフラッシュドライブ）を更新する必要があり
ます。
プレゼンテーションの詳細な保存方法については、 CHAPTER6 プレゼンテーションのPublish Publishing with Local Storageをご参照
ください。
＊時間の設定やIPアドレスを登録しない場合はStandaloneの設定をする必要はありません。

1 メニューバーから、Tools > Setup BrightSign Unitを選択すると、BrightSign Unit Setupウィンドウが開きます。

2 Name Specification ：
a NameとDescription欄に任意の文字を入力します。
b Customization
・Use name only ： Name Specification で設定した名前のみ表示
・Append unit ID ： Name Specification で設定した名前と、BrightSign本体のIDを表示

3 Network Properties ：
a Enable Wireless ： BrightSignのWirelessモデルを使用する場合にチェックを入れます。
＊BrightSignのWirelessモデルは取扱がありません。

b Time zone ： タイムゾーンの選択
c Time server ： タイムサーバーの設定

4 Advanced Network Setup ：
a Unit Configuration ：プロキシサーバーを使用する場合はチェックを入れ、アドレスとポート番号を入力します。
b Wired ： BrightSign本体にIP addressを設定します。Wiredタブをクリックし、IP addressを自動設定するにはObtain an IP address
automatically、任意に設定するにはUse the following IP addressにチェックを入れます。
＊Data Types EnabledはWirelessを選択したときのみ選択できます。

c Diagnostics ： 最初の起動時にネットワークの診断を行います。
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5 ファームウェアを更新する場合はSpecify Firmware Updateをクリックし、ファームウェアを選択します。
Firmware Updateウィンドウが表示されるので、ファームウェアを選択します。
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6 Unit Configuration ：
a Enable diagnostic web server ：diagnosticを有効にします。パスワードを設定することができます。
b Enable local web server ： チェックを入れるとパスワード設定することができます。

7 Standaloneにチェックを入れます。
a USB Content Update Password ： USBフラッシュドライブを使用してコンテンツを更新の際に、パスワードを設定できます。

8 Logging ： Loggingを有効にするにはチェックボックスのいずれかにチェックを入れ、アップロード設定を指定します。
a Enable playback logging ： プレイリストが再生された際にログを作成します。
b Enable event logging ： イベントのログを作成します。
c Enable state logging ： 現在と最後のstate names 、timestampsやmediaタイプのログを作成します。
d Enable diagnostic logging ： timestamps、firmware、Scriptバージョンや現在のプレゼンテーションのログを作成します。
e Upload logs ：
・ On startup ： スタートする度にログファイルをアップロードします。
・ At specific time each day ： 指定された時間に毎日ログファイルをアップロードします。
・ Relative URL for log handler ： ログファイルをアップロードする場所を入力します。

＊RF Channel Scan Data (optional)は国内では利用できません。

9 Setup BrightSign Unitの保存
a Create Setup Filesを選択します。
b フォルダー、SDカード、USBフラッシュドライブ（BS/XD1030、BS/XD1230、BS/HD1020、BS/HD810、BS/HD1010）のいずれか
を選択します。

c 9-b 選択後OKをクリックします。
d 電源アダプタを抜いて、BrightSign本体の電源をオフにします。BrightSign本体に9-c で保存したSDカードまたはUSBフラッ
シュドライブを接続します。

e 電源アダプタを接続して、BrightSign本体の電源をオンにします。
＊ Setup is complete – you may now remove the card とメッセージが表示されますので、メッセージ確認後SDカードを抜きます。
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フルスクリーンプレゼンテーションの作成

CHAPTER 3 プレゼンテーションの作成

画面全体に動画もしくは静止画をフルスクリーンで表示するプレゼンテーションを作成します。

1 新しいプレゼンテーションプロジェクトを作成します。
a BrightAuthorの起動 ＞ デスクトップ上にあるBrightAuthorのアイコンをダブルクリックします。
b File > New Presentation を選択します。
New Presentationが表示されない場合は、EditタブもしくはPublishタブに変更してください。

c New Project ウィンドウが開きます。
d Save as ： プレゼンテーションのファイル名を入力します。
e Where ： プレゼンテーションの保存先を選択します。
f BrightSign Model、Connector type、Screen resolution、Monitor orientationを選択します。
BrightSignのWebサイトのサポートページで、利用可能なすべての解像度を確認できます。
＊Monitor orientationでPortraitを選択してもPortraitで保存されません。このモードを使用することでPortraitをイメージしてプレ
ゼンテーションを作成することができます。

g Monitor overscanの設定
・No overscan – use full screen ： 画面全体に表示します（デフォルト設定）
・Overscan – action safe area ： ほとんどのディスプレイと互換性のあるエリアに表示します。
・Overscan – title safe area ： より小さい領域に表示します。

h Createをクリックします。

2 Select a TemplateからFull Screenを選択しChooseをクリックします。

3 Media Library
a スクリーンの左下のMedia Libraryにコンテンツが表示されます。
b Browseをクリックしコンテンツが入っているフォルダーを選択します。最初にMedia Libraryに表示されるフォルダーは
Edit > Preference > UI New BrightSign Presentation Initial Folderで選択します。
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4 Media Libraryに表示されたコンテンツをプレイリストにドラッグします。また、Windowsのエクスプローラウィンドウから直接プレイリスト
にコンテンツをドラッグすることもできます。
a Shift + クリックでコンテンツをまとめて選択できます。
b Ctrl + クリックでコンテンツを複数選択できます。
c Playlistに並んだコンテンツはドラッグして順番を変更することができます。
d Media Libraryをリフレッシュするには をクリックします。
e コンテンツを選択しDeleteキーを押すとコンテンツを削除できます。
f プレイリスト内のコンテンツを削除せずに変更するには、メニューバーから、File > Replace Media filesを選択します。
Replace Media Fileウィンドウが開くので、Browseより変更するコンテンツフォルダーを選択し、Replacement Media File
のプルダウンメニューより変更するコンテンツを選びます。
g BS/HD110を除くすべての機種はインタラクティブイベントを選択できます。
詳しくはCHAPTER 4 インタラクティブプレゼンテーションの作成 をご参照をください。

5 プレイリスト名の変更
a プレイリスト右上のEditをクリックします。
b 変更するプレイリスト名を入力します。
c OKをクリックします。

6 再生設定
a 1つの静止画の再生時間・トランジションを設定する場合は、Playlistに表示されているコンテンツをダブルクリックもしくは、
右クリックよりEditを選択します。動画の場合はボリュームの設定になります。
メニューバーのEdit > Selected Itemsからも変更できます。

b 複数の静止画の再生時間・トランジションを設定する場合は、Playlistに表示されているコンテンツを、Ctrl + クリックで複製選択
し、右クリックよりEditを選択します。動画の場合はボリュームの設定になります。
メニューバーのEdit > Selected Itemsからも変更できます。

c プレイリストでプレイリスト上のコンテンツをすべて選択する場合は、最初のコンテン
ツをマウスでクリックし、任意のコンテンツの場所でShift+マウスクリックします。
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7 メニューバーのFile → Save・・・でプレイリストを保存できます。
別名で保存する場合はSave・・・Asを選択して下さい。

8 プレゼンテーションの保存方法については、 CHAPTER6 プレゼンテーションのPublishをご参照ください。

マルチゾーンプレゼンテーションの作成

BrightAuthorでマルチゾーンプレゼンテーションを作成できます。分割した各画面をゾーンと呼び、ゾーンごとに異なるコンテンツを再
生させることができます。標準のテンプレート（Select Template)以外にも、自由にカスタマイズすることができます。
詳しくはCHAPTER7 プレゼンテーションのカスタマイズをご参照ください。

マルチプレゼンテーションを使用する場合は下記をご確認ください。
各項目ごとに色分けされて表示されます。

・ Images ： 静止画表示、複数のImagesゾーンを作成できます。

・ Ticker ： RSSフィードまたはテキストを表示、複数のTickerゾーンを作成できます。

・ Clock ： ディスプレイ上に時間または日時を表示、複数のClockゾーンを作成できます。

・ Video or Images ： 動画と静止画を表示、Video or Imagesは1つのゾーンのみ作成できます。

・ Video Only ： 動画表示、Video Onlyは1つのゾーンのみ作成できます。

・ Audio Only ： オーディオ再生、Audio Onlyは2つまでゾーンを作成できます。

・ Background Image ： プレゼンテーションの背景に静止画を表示します。Background Imageを選択すると、Video or Images、
Video Onlyは選択できません。またBackground Imageは1つのゾーンのみ作成できます。

NOTE ： XDシリーズ(XD230、XD1030、XD1230)を使用の場合のみ、2つのVideo or ImagesまたはVideo Onlyを作成できます。その
他の製品はVideo or Images、Video Only、Background Imageのいずれか1つのゾーンのみ作成できます。
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1 新しいプレゼンテーションプロジェクトを作成します。
a BrightAuthorの起動 ＞ デスクトップ上にあるBrightAuthorのアイコンをダブルクリックします。
b File > New Presentation を選択します。
New Presentationが表示されない場合は、EditタブもしくはPublishタブに変更して下さい。

c New Project ウィンドウが開きます。
d Save as ： プレゼンテーションのファイル名を入力します。
e Where ： プレゼンテーションの保存先を選択します。
f BrightSign Model、Connector type、Screen resolution、Monitor orientationを選択します。
g Monitor overscanの設定
・No overscan – use full screen ： 画面全体に表示します（デフォルト設定）
・Overscan – action safe area ： ほとんどのディスプレイと互換性のあるエリアに表示します。
・Overscan – title safe area ： より小さい領域に表示します。

h Createをクリックします。

2 Select a Templateからマルチゾーン（Full screen以外）を選択しChooseをクリックします。

3 Media Library
a スクリーンの左下のMedia Libraryにコンテンツが表示されます。最初にMedia Libraryに表示される
フォルダーはEdit > Preference > UI New BrightSign Presentation Initial Folderで選択します。

b Browesをクリックし、コンテンツが入っているフォルダーを選択します。

4 プレイリストの各ゾーンにコンテンツを追加
a コンテンツを追加したいゾーンを選択します。
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b Media Libraryに表示されたコンテンツをプレイリストにドラッグします。また、Windowsのエクスプローラウィンドウから直接プレイリスト
にコンテンツをドラッグすることもできます。

・ Shift + クリックでコンテンツをまとめて選択できます。
・ Ctrl + クリックでコンテンツを複数選択できます。
・ Playlistに並んだコンテンツはドラッグして順番を変更することができます。
・ Media Libraryをリフレッシュするには をクリックします。
・ コンテンツを選択してDeleteキーを押すとコンテンツを削除できます。
・ プレイリスト内のコンテンツを削除せずに変更するには、メニューバーから、File > Replace Media Filesを選択します。
Replace Media Fileウィンドウが開くので、Browseより変更するコンテンツフォルダーを選択し、Replacement Media File
のプルダウンメニューより変更するコンテンツを選びます。

・ BS/HD110を除くすべての機種はインタラクティブイベントを選択できます。
詳しくはCHAPTER 4 インタラクティブプレゼンテーションの作成をご参照ください。



28

5 新しいゾーンを追加する場合には、EditタブからLayoutを選択し、Add Zoneボタンを選択します。
詳細はCHAPTER7 プレゼンテーションのカスタマイズ レイアウトのカスタマイズをご参照ください。

6 プレイリスト名の変更
a プレイリスト右上のEditをクリックします。
b 変更するプレイリスト名を入力します。
c OKをクリックします。

7 再生設定
a 1つのコンテンツの再生時間・トランジションを設定する場合は、Playlistに表示されているコンテンツをダブルクリックもしくは、
右クリックよりEditを選択します。
メニューバーのEdit > Selected Itemsからも変更できます。

b 複数のコンテンツの再生時間・トランジションを設定する場合は、Playlistに表示されているコンテンツをShift+マウスクリックし
ます。メニューバーのEdit > Selected Itemsからも変更できます。

8 ゾーンのプロパティ設定につきましては、 CHAPTER7 プレゼンテーションカスタマイズ Zone propertiesの設定をご参照ください。

9 メニューバーからFile > Save… でプレイリストを保存できます。別名で保存する場合はSave・・・Asを選択して下さい。
10 プレゼンテーションの保存方法につきましては、 CHAPTER6 プレゼンテーションのPublishをご参照ください。
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HTML5の追加

BrightSign XD230、XD1030、XD1230ではビデオ、画像、テキスト、JavaScriptを含んだHTML5のWebページを表示できます。
BrightSignを使用してHTML5のコンテンツを作成、表示の詳細につきましては、下記のHTML5 User Guideをご参照ください。

＊BrightSign XDシリーズは汎用のWebブラウザーとして使用するように設計されていません。多くのWebページがBrightSign XDシリー
ズで正しく表示できない要素があります。FlashコンテンツやYouTubeなどのHTMLのページに埋め込まれた映像コンテンツは正しく表
示できないケースがあります。

BrightSign Documentation
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting

・ State name ： HTML5に名前を入力します。HTML5 Siteのプルダウンから使用するHTML siteを選択します。HTML siteを事前
に登録しておく必要があります。 File > Presentation Properties >HTML Sites

・ Enable external data ： HTML5のページが複数の場所からアセットを使用している場合は、チェックを入れます。
・ Enable mouse and touch events ： HTML5のページ(JavaScriptコンテンツなどの相互作用、関連するリンク)でインタラクティブ
を有効にする場合は、チェックを入れます。

・ Display cursor ： XDのシリーズでマウスを使用する場合は、チェックを入れます。
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Live Data、Text、RSS、Media RSSフィードの追加

ネットワーク機能に対応したBrighSignではRSSフィードを表示することができます。RSSフィード（テキスト）またはMedia RSS（ビデオフ
ィードなど）を追加することができます。BrightSign Networkのアカウントがあれば、Live Data Feedsを使用できます。

Live Data Feeds
BrightSign Networkの有料サービスのアカウントが必要です。ご利用の際には弊社までお問い合わせください。

RSS Feeds
1 Ticker Zoneを選択します。
2 Media LibraryからNew RSS Feedをプレイリストにドラッグします。
a Select Data FeedからRSSフィードを選択します。事前にData Feedに登録すると、プルダウンメニューに表示されます。Data 
Feedに登録していない場合はAdd Data FeedボタンをクリックしRSSフィードを追加します。

b OKボタンをクリックし、ウィンドウを閉じます。
＊日本語フォントを表示する場合は、フォントを設定する必要があります。Zone Propertiesからフォントを設定してください。

Media RSS Feeds
1 Media Libraryのotherタブを選択します。
2 Media RSS Feedアイコンをプレイリストにドラッグします。LibraryからNew RSS Feedをプレイリストにドラッグします。
a Add RSSウィンドウが表示されます。URL for RSS FeedにURLを入力します。
b OKボタンをクリックし、ウィンドウを閉じます。

Text Feeds
1 最初にテキストファイルを作成する必要があります。
＊日本語を表示させる場合は、テキストファイルを保存する際に文字コードをUTF-8に設定します。

2 Ticker Zoneを選択します。
a Media LibraryからTextタブを選択し、作成したテキストファイルをプレイリストにドラッグします。

＊日本語フォントを表示する場合は、フォントを設定する必要があります。Zone Propertiesからフォントを設定してください。
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Twitter
1 Ticker Zoneを選択します。
2 Media LibraryのRSSタブからTwitterイベントをプレイリストにドラッグします。
3 Add Twitter Feedウィンドウが表示されます。Twitter User NameにUser Nameを入力しAuthenticateボタンをクリックします。
4 Twitterの認証ページが表示しますので、ユーザー名、パスワードの認証を行います。
5 Update IntervalにTwitterの更新間隔を設定します。
6 OKボタンをクリックします。

Twitterの追加

Live Video
Video ZoneまたはVideo or Image Zoneを選択します。Media Libraryのotherタブを選択し、Live Videoイベントをプレイリストにドラッグ
します。

Live Video、Sign Channelの追加

Twitterのアカウントを使用しTicker ZoneにTwitterの情報を表示できます。

XD1230はHDMIの入力をサポートしています。SignChannelを使用する場合は、別途契約が必要です。詳細については、弊社までお
問い合わせください。

Dynamic Playlist、Local Playlistの追加

BrightSign Networkの有料サービスのアカウントが必要です。ご利用の際には弊社までお問い合わせください。
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・ State Name ： 名前を入力します。入力した名前はプレイリストのサムネイルに表示されます。
・ URL for video stream ： 表示するストリームのURLを入力します。
・ Rotation (Mjpeg only) ： ストリームデータの回転を指定します。
・ Time on screen ： ストリームを表示する時間を設定します。このオプションはnon-interactiveの場合のみ設定できます。インタラク
ティブなプレゼンテーションでは、タイムアウトかメディアエンドイベントを使用します。

Video、Mjpeg ストリームの追加

Audio Streamの追加

全てのネットワーク対応モデルはVideo,Mjpegのストリームを表示できます。

XD230,XD1030,XD1230,HD220,HD1020はリモートソースからオーディオをストリーミングできます。ストリームを追加するには、State 
NameとURLを設定します。Non-interactiveのプレゼンテーションの場合では再生する時間を指定します。サポートされているフォーマ
ット、コーデック、ビットレートの詳細につきましては、下記をご参照ください。

What Audio Streaming Codecs and Formats Do BrightSign Players Support?
http://support.brightsign.biz/entries/21875720-What-Audio-Streaming-Codecs-and-Formats-Do-BrightSign-Players-Support-

RF in (ATSC)、Tuner Scanの追加

国内はご利用いただけません。
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BrightAuthorを使用してインタラクティブプレゼンテーションを作成することができます。
インタラクティブプレゼンテーションではGPIO、シリアル、USBキーボード、USBマウス、タッチパネルなど様々な機器の入力を受けるこ
とができます。

RS232 シリアルデバイス対応モデル ： BS/XD1230、BS/XD1030、BS/HD1020、BS/HD410、BS/HD810、BS/HD1010
USBデバイス対応モデル ： BS/XD1230、BS/XD1030、BS/HD1020、BS/HD810、BS/HD1010
イーサネットデバイス対応モデル ： BS/XD1230、BS/XD1030、BS/XD230、BS/HD220、BS/HD1020、BS/HD210、BS/HD1010

1 プレゼンテーションファイルを開きます
プレゼンテーションファイルを作成していない場合は、プレゼンテーションファイルを作成する必要があります。
CHAPTER 3 プレゼンテーションの作成 フルスクリーンプレゼンテーションの作成もしくはマルチゾーンプレゼンテーションの作成
をご参照ください。

a BrightAuthorの起動 ＞デスクトップ上にあるBrightAuthorのアイコンをダブルクリックします。
b File > Open Presentationを選択します。
Open Presentation、New Presentationが表示されない場合は、EditタブもしくはPublishタブに変更してください。

c プレゼンテーションを選択します。

CHAPTER 4 インタラクティブプレゼンテーションの作成

2 インタラクティブプレイリストに変更
a プレゼンテーションが開いたら、プレイリスト右上のInteractiveにチェックを入れ、プレゼンテーションタイプをインタラクティブ
に変更します。
＊マルチゾーンプレゼンテーションを作成している場合は、Interactiveと
non-interactiveプレゼンテーションを組合せて使用することができます。

CHAPTER 4 インタラクティブプレゼンテーションの作成

インタラクティブプレゼンテーションの作成
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3 スクリーン左下のMedia Libraryにコンテンツが表示されます。Browseをクリックしコンテンツが入ったフォルダーを選択します。

4 Media Libraryに表示されたコンテンツをプレイリストにドラッグします。
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5 ホーム画面を選択
ホームアイコン はインタラクティブプレゼンテーションを作成したときに表示されます。
始めに表示するコンテンツにホームアイコン が表示されます。
ホームアイコンを設定しない場合、最初に選んだコンテンツに表示されます。
ホーム画面の設定は変更することができます。

・ホーム画面の変更手順
プレイリスト上のコンテンツをダブルクリックし、Set as initial stateにチェックを入れOKをクリックします。

6 インタラクティブイベントの設定
a プレイリスト上にあるツールバーで、使用するインタラクティブイベントをクリックします。
例えばGPIOボタン1 が選択された場合のイベントを設定します。

b イベントを設定するコンテンツの下部をクリックします。マウスポインタが手のマークになります。
c コンテンツ下部をクリックし、次に表示するコンテンツまでマウスをドラッグします。
＊インタラクティブはホームから設定する必要があります。

d 他のコンテンツでイベントを設定するときは、上記の(a - c)の設定をします。

・ interactiveタイプのプレイリストでCtrl+Aを押すと全てのコンテンツを選択します。

下記の図では、ホーム画面からGPIOボタン1、GPIOボタン2を押すことにより、他のコンテンツに移動します。
Timeout Event使用することで指定された時間を経過すると、ホームのコンテンツに戻ります。
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プレイリスト領域のイベントアイコンの右にあるZoomバーを使用することにより、プレイリストを縮小・拡大することができます。

プレイリストのツールバーに必要なイベントが表示されていない場合は、Zoomバーの左横にある矢印をクリックします。
イベントアイコンにチェックを入れることで、ツールバーにイベントアイコンを追加、またはチェックを外すことでツールバーからイベント
アイコンを削除することができます。

インタラクティブプレゼンテーションの編集
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イベントアイコンをダブルクリックすると、詳細な設定をすることができます。
タイムイベントアイコンを使用してイベントを作成する場合は、プレイリスト上に表示されているタイムイベントアイコンをダブルクリックす
ると、Timeout Eventの設定画面が表示されます。
Specify timeout (seconds)の欄で表示する秒数を決めることができます。

インタラクティブイベントの編集

メディアプロパティの編集

インタラクティブプレイリスト上でドラッグして作成されたイベントは、ダブルクリックすると
下記を選択することができます。

・ Transition to new state ： 次のコンテンツを指定するときに設定します。
・ Return to prior state ： このオプションを選択すると、インタラクティブイベントが実行されると前のコンテンツに戻ります。
・ Remain on current state ： このオプションを選択すると、インタラクティブイベントが実行されても次のコンテンツに移動しません。
１つのコンテンツに対して、Add commandを使用する際に使用します。
詳細については、 Adding Commandsをご参照ください。

・ Advanced ： インタラクティブプレイリストでは、6 (a – c)の設定を行うと次のコンテンツまで矢印で繋がれます。
Advancedにチェック入れると、Display Options 、Label locationが表示されます。
次のコンテンツまで矢印で繋ぐ場合は、Show lineにチェックを入れます。Show labelにチェックを入れると、Label locationが表
示されます。
Bottomにチェックを入れるとラベルが下に表示され、Rightにチェックを入れるとラベルが右側に表示されます。詳細について
は、 Adding Commandsをご参照ください。

プレイリストのコンテンツ上で右クリックし、Editを選択するとMedia Propertiesウィンドウが開きます。
Transition、コンテンツの入れ替えなど、コンテンツごとに個別の設定・変更ができます。

コンテンツを選択しDeleteキーを押すとコンテンツを削除できます。
プレイリスト内のコンテンツを削除せずに変更するには、メニューバーから、File > Replace Media Filesを選択します。
Replace Media Fileウィンドウが開きますので、Browseより変更するコンテンツフォルダーを選択し、
Replacement Media Fileのプルダウンメニューより変更するコンテンツを選びます。
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Media ListとPlay Filesは複数のコンテンツを１つのサムネイルとして表示し、コンテンツを登録します。同じ種類のコンテンツだけが
Media ListやPlay Fileに登録できます。複数のアイテムを含むプレゼンテーションを作成するときに便利です。

・ Media Lists ： Image List, Audio List, and Video List. 
・ Play Files ： Image Play File, Audio Play File, and Video Play File. 

Media ListやPlay Listを使用するには、プレイリストのタイプをInteractiveに設定し、Media Libraryのotherタブの中にある各イベント
のいずれかのアイコンをドラッグします。プレイリストにアイコンをドラッグすると、Listウィンドウが表示されます。

Media List – 登録したコンテンツは順番に再生、またはシャッフル再生することができます。

・ Media list name ： リストの名前を作成します。
・ Set as initial state ： チェックボックスにチェックを入れると、ホーム設定になります。
・ Advance to next item on media end event （Image Timeout) ： チェックボックスにチェックを入れると、コンテンツ再生終了時
にList内の次のコンテンツに移動します。

・ Image Timeout (seconds) ： Advance to next item on Image Timeoutにチェックを入れると選択できるようになります。コンテン
ツの表示時間（秒数）を設定します。＊Image Listの場合のみ表示されます。

・ Play from beginning on entry to state ：チェックボックスにチェックを入れるとListの最初のコンテンツを表示します。
・ Shuffle playback ： チェックボックスにチェックを入れると、ランダム再生設定になります。
＊ランダム設定を選択した場合にリスト内の特定のファイルを再生しない可能性があります。

・ Event to transition to next item ： 次のコンテンツへ移動するインタラクティブイベントを設定します。
・ Event to transition to previous item ： 1つ前のコンテンツへ移動するインタラクティブイベントを設定します。
・ Media Library ： Media Filesに追加するコンテンツのフォルダーを選択します。
・ Media Files ： Add Fileを選択しコンテンツを追加します。
さらにコンテンツを増やす場合にはAdd Fileを選択します。
コンテンツの順番を入れ替える場合は矢印（↑↓）を選択し、
コンテンツを削除する場合は（×）を選択します。

・ Commands ： リストにコマンドを追加します。コマンドの詳細に
ついては、 Adding Commandsをご参照ください。

＊File > Presentation Properties > Media Listタブから
Media Listsのプロパティを編集することができます。
詳細については、 Zone Propertiesの設定をご参照ください。

Media List、Play Files
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Play File –複数のコンテンツを１つのサムネイルとして表示し、登録したコンテンツはBP900/BP200（オプション品）、シリアル、UDP、
キーボード、USBの信号を受けることで、再生することができます。

・ State name ： Play Fileに名前を入力します。入力した名前はプレイリストのサムネイルに表示されます。
・ Transition (image Play Files only) ： プルダウンメニューからトランジションを選択します。 ＊Image Play Fileの場合のみ表示さ
れます。

・ Files ： 再生するファイルを表示します。
・ Key ：Filesに登録したファイルを再生するインタラクティブイベントを設定します。例えばコンテンツとPlay FileをUSBイ
ベントで結ぶとSpecify USB Inputには、<any>と表示され、インタラクティブイベントで登録したキーが入力されると
再生を開始します。

・ File ：コンテンツが保存してあるフォルダーを選択します。
・ Display Mode (Video Play Files only) ： デフォルトでは2Dに設定されています。3D映像を使用している場合は、3D side-
by-side 、 3D top-over-bottomを選択することができます。 ＊Video Play Fileの場合のみ表示されます。

・ Add File ： Add Fileボタンをクリックして、コンテンツを登録します。
・ Import Table ： 以前作成したリストをインポートする場合にこのボタンをクリックします。詳細な設定方法については、下記
BrightSign社のWebサイトをご参照ください。

http://brightsign.zendesk.com/entries/21135706-how-do-i-create-and-import-a-table-for-a-play-file

・ Commands ： リストにコマンドを追加します。コマンドの詳細については、 Adding Commandsをご参照ください。
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・ State name ： 作成するライブテキストの名前を入力します。

・ Set as initial state ： チェックボックスにチェックを入れると、ホーム設定になります。

・ Background Image ： 背景画像を選択します。

・ Update Live Text Data ： RSSフィードを更新します。（BrightSign Networkのアカウントが必要です）

・ Size ： テキストフィードのサイズを設定します。

・ Position ： テキストフィードの位置を設定します。

＊背景画像の上に表示されているテキストフィードをクリックすると、サイズや位置を変更することができます。

・ Offset next ： テキストフィードを追加し、追加したテキストフィードの位置を設定する場合にチェックを入れます。
XフィードとYフィードに次のテキストフィードまでの距離を入力します。

・ Type ： プルダウンメニューで表示するテキストの種類を変更します。

a Fixed text ： 任意の文字を入力する場合に選択します。入力する欄はText typeの下に表示されます。日本語を表示する
場合はフォントを指定する必要があります。Set Text Parametersボタンをクリックし、フォントを設定します。

b System variable ： 本体のシリアル番号、ファームウェアのバージョン、スクリプトのバージョンのいずれかを表示します。

c Live Text data ： テキストフィード内にRSSフィードを表示する場合に選択します。プルダウンメニューに表示させるには、
最初にFile > Presentation PropertiesのDate Feedsダブで設定する必要があります。RSSフィードの作成とカスタマイズの
詳細については、Presentation Propertiesの編集をご参照ください。 またAdd Date FeedでもRSSフィードを設定できます。
Item title、Item indexが分かる場合は、いずれかにチェックを入れます。

d Media Counter ： プレゼンテーションの再生回数を表示します。カウントするコンテンツをプルダウンメニューから選びま
す。この機能を有効にするには、最初に下記手順でAutomatically create media counter variableを有効にする必要が
あります。File > Presentation Properties > Variablesタブで, Automatically create media counter variables にチェックを
入れます。

Live Text – Live Textを使用するには、プレイリストにotherタブの中にあるLive Textアイコンをドラッグします。
プレイリストにアイコンをドラッグすると、Live Textウィンドウが表示されます。

Live Text

Live Textを使用することでより効果的にプレゼンテーションファイルを作成できます。
Live Textでは複数の領域に文字入力することができ、静止画や動画の上に文字を表示することができます。
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e User variable ： コマンドで使用できるカスタマイズ可能な値です。指定したUser variableの現在の値を表示します。
この項目を使用するには、User Variableを作成する必要があります。

f RSS Feed ： RSSフィードを使用するには、このオプションを選択します。Update RSS URL Listボタンをクリックします。Add 
Data Feedsボタンをクリックすると、Data Feedsを作成することができます。

g Media RSS Feed ： Media RSSフィードを使用するには、このオプションを選択します。Update Media RSS URL Listボタン
をクリックします。Add Data Feedsボタンをクリックすると、Data Feedsを作成することができます。

h Image ： 背景画像の上に別の画像を表示するには、このオプションを選択します。Browseボタンをクリックし表示する画像
を選択します。
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・ Validate Live Text Data ： 有効なURLであるかを確認する場合は、このボタンをクリックします。

・ Layer ： ライブテキストの階層を変更することができます。

・ Set Text Parameters ： テキスト表示方法を設定することができます。

・ Add Item ： 新しいテキストフィードを作成します。

・ Previous/Next Buttons ： テキストフィードの切替を行います。
・ Advanced ： コマンドを設定します。詳細については、Adding Commandsをご参照ください。
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Live Text Image ： Live Textの背景に静止画を使用する場合は、下記の手順で設定します。

a Images Zoneを選択し、Playlistをinteractiveに設定します。プレイリストにotherタブの中にあるLive Textアイコンをドラッグします。

b Live Textウィンドウが表示されます。 State nameに名前を入力し、BrowseからBackground Imageを選択します。

c テキストフィードを追加するには、Add Text Itemをクリックします。テキストフィードはマウスで移動できますが、Size、Positionを
入力することで、正確に表示位置を指定することもできます。

d Text Typeプルダウンメニューで表示するテキストの種類を変更します。

e Set Text Parameters でテキスト表示方法を設定することができます。

f OKをクリックし、設定を反映させます。

Live Text Video ： Video ZoneにLive Textを表示させることはできません。Video ZoneとImage Zoneの2種類を使用することで、動画の上
にLive Textを表示させることができます。

a Layoutタブを選択します。Add ZoneからVideo Only zoneを追加します。

b 次にAdd Zoneをクリックし、Images zoneを追加します。Video zoneに重なるように、Images zoneのサイズを変更します。

c Playlistをクリックし、PlaylistのタイプをInteractiveに変更します。Video Zoneをプルダウンメニューから選択し、Media Libraryか
ら動画ファイルをPlaylistにドラッグします。

d Image Zoneをプルダウンメニューから選択し、PlaylistのタイプをInteractiveに変更します。Otherタブの中にあるLive Textアイコ
ンをPlaylistにドラッグします。

e Live Textウィンドウで、背景画像の選択、テキストの入力をすることができます。

f テキストフィードを追加するには、Add Text Itemをクリックします。テキストフィードはマウスで移動できますが、Size、Positionを入
力することで、正確に表示位置を指定することもできます。

g Text Typeプルダウンメニューで表示するテキストの種類を変更します。

h Set Text Parameters でテキスト表示方法を設定することができます。

i OKをクリックし、設定を反映させます。
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この機能を使用するとDVDのメニュー画面のような表示を作成することができます。

Interactive Menuを作成するには、プレゼンテーションのタイプをVideo or Images zoneに設定します。プレイリストのotherタブの中
にあるInteractive Menuアイコンをドラッグします。プレイリストにアイコンをドラッグすると、Interactive Menuウィンドウが表示されま
す。Interactive MenuウィンドウはGeneralとMenu Itemの2項目で構成されています。

Generalタブ ： ナビゲーションの設定を行います。

・ State name ： 作成するインタラクティブメニューの名前を入力します。

・ Background Image ： メニュー画面として表示させる画像を選択します。

＊ 設定するBackground Imageは、メニューやテキストなどを含めた画像を用意しておく必要があります。

・ Set as initial state ：チェックボックスにチェックを入れると、ホーム設定になります。

Navigationで各項目をプルダウンメニューで選択します。プルダウンメニューの設定ではUp , Down , Left , Right , Enter , Back ,
Next clip , Previousに対してGPIO Event , Serial inputなどのイベントを選択します。
プルダウンメニュー選択後、テキストフィードが表示されます。利用するボタンや入力を設定します。

Interactive Menus



45

例えば、メニュー移動でUpの設定をキーボードイベントに設定します。
まずプルダウンメニューからキーボードイベントを選択し、次にテキストフィードに”U”と入力します。
これでユーザーがキーボードの”U”を押したときに、カーソルがメニューに沿って移動します。
ナビゲーションの全ての項目に設定をする必要はありません。
Noneを選択するとデフォルトの設定になります。Navigationで設定できるアクションは下記の通りになります。

・ Up, Down, Left, Right ： 次のメニューに移動するアクションを設定します。

・ Enter ： ボタンを押すと選択されたMenu itemで選択したコンテンツを表示します。

・ Back ： ボタンを押すとBackground Imageに戻ります。

・ Next clip ： ボタンを押すとMenu itemで選択された次のコンテンツを表示します。

・ Previous clip ： ボタンを押すとコンテンツが停止し、Menu itemで選択された１つ前のコンテンツを表示します。

・ Advanced ： インタラクティブメニューにコマンドを追加するには、Advancedをクリックします。詳細につきましては、Adding 
Commandsをご参照ください。Background Imageをキャッシュに保存するにはチェックボックスをオンにします。

Menu Itemsタブ ： このタブではMenu Itemsを作成し、メニュー全体の操作方法を指定します。

・ Menu Item Number ：すべてのメニュー項目は番号を持ちます。最初に作成したものは１番となります。
Previous、Nextのボタンを選択することで、作成したメニュー項目を移動することができます。

Menu Item ： このセクションではMenu Itemsの調整、追加をすることができます。

・ Add Menu Item ：このボタンクリックすると、Menu Itemsが追加されます。Add Menu Itemウィンドウ画面が開き、Active 
ImageとInactive Imageの項目が表示されます。Active Imageはメニュー画面上でMenu Itemsが選択されたときの画像を
表示します。Inactive Imageではメニュー画面上で他のMenu Itemsが選択されたときに表示する画像を表示します。各画
像を選択するには、Browseボタンをクリックして選択します。

作成したメニュー項目は、Backgroundイメージの上に表示し、イメージの横にMenu Item numberが表示されます。
Menu Item numberを選択しているMenu ItemsにはActive Imageの画像が表示されます。
＊選択されてないときに、何も表示させない場合は、背景色に合ったInactive Imageを選択してください。

・ Position ：数値を入力することにより、Menu Itemsの位置を微調整することができます。右の画面のプレビュー画面で
Menu Itemsを選択すると、マウスで移動することもできます。
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・ Offset next ：チェックを入れると、Add Menu Itemで追加されたMenu Itemは前回と同じ場所に追加されます。
XとYの座標を指定すると、指定された場所にMenu Itemを追加することができます。



47

・ Selected Image ：メニュー画面上でメニュー項目が選択されたときの画像です。Browseから任意の画像を選択します。

・ Unselected Image ：メニュー画面上で他の項目が選択されたときに表示する画像。Browseから任意の画像を選択します。

・ Store image in cache ：チェックを入れることにより、イメージをキャッシュに保存します。

Navigation ： このセクションでは次のMenu Itemへの移動を設定します。Up、Down、Left、Rightの設定が可能です。プルダ
ウンメニューでは作成したMenu Itemの番号が表示されます。Menu Itemの選択はプレビューウィンドウかMenu Item number
から選択できます。
Menu item numberでPreviousとNextの間にメニュー項目の番号が表示されます。１と表示されていたら、メニュー項目の１番
を編集することができます。Add Menu ItemでMenu Itemを追加すると、Navigationのドロップダウンメニューに追加された
Menu Itemが表示されます。

Enter ： このセクションでは特定のMenu ItemでEnterを選択した場合の動作を設定します。

・ Play clip ： Enterを押したときに表示するコンテンツを選択します。

・ Transition to new state ： ドロップダウンメニューのリストにはプレイリストに配置しているコンテンツを選ぶことができます。

・ Return to prior state ：イベントが実行されると前のコンテンツに戻ります。

・ Remain on current state ：このオプションを選択すると、次のコンテンツに移動しません。
１つのコンテンツに対して、Commandsを使用する際に使用します。
詳細については、Adding Commandsをご参照ください。
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・ プレゼンテーションがアクティブになるまで、ホーム画面を表示させない。

・ 動画コンテンツ終了時に、最後のフレームで止める。

Event Handlers

Event Handlersを使用すると、ブランクの画面から表示することができます。この機能を使うことにより、下記のような表示を行うこ
とができます。

Event Handlerはコンテンツを含みませんが、インタラクティブイベントやコマンドを追加することができます。
例えばホーム画面にEvent Handlerを設定し、最初のファイルがGPIO 1の信号を受けて再生するように設定します。この設定をす
ることで、GPIO 1の信号の入力がない場合は、ブランク画面のままになります。また同期再生で使う場合は、Event Handlerを
使うことで最初のブランク画面の画像が不要になります。

Media Libraryの下に表示されているotherタブを選択します。次にEvent Handlerアイコンを選択してプレイリスト画面にドラッグし
ます。プレイリスト上にあるEvent Handlerをダブルクリックすると、詳細な設定ができます。

1. State Name ： 任意の文字を入力します。
2. Stop Playback ： チェックボックスにチェックを入れると、コンテンツが再生終了時にEvent Handlerに戻ります。
3. Stet as initial state ： チェックボックスにチェックを入れると、ホーム画面になります。

Event Handlerはインタラクティブイベントで使用することができます。インタラクティブイベントの設定については、CHAPTER 4
インタラクティブプレゼンテーションの作成をご参照ください。
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Adding Commands

コマンドを追加することで、プレゼンテーションに拡張機能を追加することができます。拡張機能を使用することにより、GPIOからのラ
ンプのON/OFFや、プロジェクターのON/OFF、動画の一時停止など様々な設定をすることができます。

コマンドは2つの異なる方法で追加できます。インタラクティブイベントにコマンドを追加すると、イベントが発生したときにコマンドが実
行されます。メディアファイルにコマンドを追加するとファイルを再生したときに実行されます。

インタラクティブイベントにコマンドを追加
プレイリスト内のイベントアイコンをダブルクリックし、Advancedのタブをクリックします。Add Commandを選択しCommandsのプルダウン
メニューから使用するコマンドを選択します。関連するコマンドがCommand Parametersに表示されます。

メディアファイルにコマンドを追加
プレイリスト内のメディアファイルのサムネイルをダブルクリックし、Advancedのタブをクリックします。 Add Commandを選択し
Commandsのプルダウンメニューから使用するコマンドを選択します。関連するコマンドがCommand Parametersに表示されます。

Note ： Advancedのタブにいくつかのオプションがあります。このオプションはファイルタイプによって異なります。
イメージファイルでは、Store Image in Cacheのチェックボックスが表示されます。キャッシュ内に保存することで、読み込み速度が向
上します。ビデオファイルでは、Video Display Modeが表示されます。ビデオファイルの種類に応じて適切なモード(2D、3D side-by-
side、3D top-over-bottom)を選択します。デフォルトでは2D が選択されています。

プレゼンテーションに追加できるコマンドリスト ：

Set Panel Output ： BP900、BP200ボタンパネルにコマンドを送信します。使用するボタンパネルの種類を選択します。
・ Button number ： 使用するボタンの番号を選択します。
・ Action ： LEDのON/OFFを設定、点灯ボタン、点滅スピードの設定ができます。

Set Audio ： オーディオの設定を変更します。
NOTE ： 再生しながら音声出力のモードを変更する場合は再起動するか、再び再生されるまでは有効になりません。
・ Zone ： 設定を変更するゾーンを選択します。
・ Audio Output ： アナログ、HDMI、SPDIFオーディオの出力を変更します。
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・ Pass through ： オーディオを外部機器でデコードする場合は、このオプションを使用します。
・ Stereo ： HDMI、SPDIFコネクタを介してデコードされた音声信号を出力します。
・ Audio Mixing ： 出力するステレオを設定します。

Connector Volume ： 特定のコネクターのオーディオの設定を変更します。
・ Set ： オーディオのボリュームを設定します。
・ Increment ： 指定のボリュームレベルを増加させます。
・ Decrement ： 指定のボリュームレベルを減少させます。
・ Mute ： オーディオの出力をOFFにします。
・ Unmute ： オーディオの出力をONにします。

Zone Volume ： ゾーンのボリュームを設定します。
・ Set ：設定を変更するゾーンを選択します。
・ Increment ： 指定のボリュームレベルを増加させます。
・ Decrement ： 指定のボリュームレベルを減少させます。

Send ： 下記のコマンドを送信します。
・ Send Zone Message ： Zone Messageのトリガーを設定します。
・ UDP ： UDPプロトコルを使用して、デバイスにコマンドを送信します。
・ Send IR Remote ： 3.5mmIROutport（XDシリーズ）を経由しコマンドを送信します。詳細についてはAppendix Aを参照ください。
・ Send string (EOL) ： 指定されたシリアルポートに指定された文字列を送信します。CRを最後に追加します。
・ Send string (no EOL) ： 指定されたシリアルポートに指定された文字列を送信します。CRは追加されません。
・ Send byte ： 指定されたシリアルポートにバイトを送信します。
・ Serial bytes (comma separated) ： Comma separated形式で指定されたシリアルポートにバイトを送信します。

Link ： ゾーンのリンク、またはBrightSignプレイヤーの同期設定をします。
・ Synchronize ： 同期のトリガーを設定します。
・ Zones ： リンクゾーンのトリガーを設定します。

GPIO ： GPIOコマンドを送信します。
・ GPIO On ： GPIO出力をONにします。
・ GPIO Off ： GPIO出力をOFFにします。
・ GPIO Set State ： 各GPIOのラインをONまたはOFFにします。

Video ： ビデオ再生の設定をします。
・ Pause Video ： 動画を一時停止します。
・ Resume Video ： 一時停止を解除します。
・ Enable monitor power save mode ： モニターのパワーセーブモードをONにします。
・ Disable monitor power save mode ： モニターのパワーセーブモードを解除します。
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BrightControl ： モニターなどのデジタルサイネージディスプレイにコマンドを送信します。
NOTE ： 接続機器がCECに対応している必要があります。
・ Display On ： モニターをONにします。＊CEC対応モニターに限ります。
・ Display Off ： モニターをOFFにします。＊CEC対応モニターに限ります。
・ Send Ascii String ： CECコマンドを送信します。
・ Set Philips Volume ： Philips TVのモニターを設定します。

Other ： 上記のカテゴリに含まれないコマンドを送信します。
・ Pause ： ミリ秒指定で動画を一時停止します。
・ Reboot ： BrightSign本体を再起動します。
・ Set Variable ： User variableに指定した値を設定します。Variableフィールドでは2つの$記号の間にVariableの正確な名前を入
力します。 例えば”$$variable1$$”と入力する必要があります。BrightAuthorでは$記号なしではVariableを認識できません。
Valueフィールドで新しいVariableの値を設定します。
・ Increment Variable ： 指定されたUser variableの値を１ずつ増加させます。Variableフィールドに2つの$記号の間にVariableの
正確な名前を入力します。 例えば”$$variable1$$”と入力する必要があります。BrightAuthorでは$記号なしではVariableを認
識できません。
・ Decrement Variable ： 指定されたUser variableの値を１ずつ減らします。Variableフィールドに2つの$記号の間にVariableの
正確な名前を入力します。 例えば”$$variable1$$”と入力する必要があります。BrightAuthorでは$記号なしではVariableを認
識できません。
・ Reset Variable ： User Variablesをリセットします。
・ Switch to Presentation ： 複数のプレゼンテーションを作成し、プレゼンテーションを切り替えることができます。
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Conditional Targets

Conditional TargetsはUser Variableの値に応じてイベントの移行の設定を変更することができます。1つのイベントに対して複数の
Conditional Targetsを設定することができます。

1． Advancedのタブを選択します。
2． Set Conditional Targetsボタンをクリックします。
3． Add Additional TargetをクリックするとConditional Targetsウィンドウが開きます。
4． プルダウンメニューよりUser Variableを選択します。
5． 隣りのプルダウンメニューでは右側のフィールドに設定する変数と比較する条件を選択します。
a. Between
b. Less than (<)
c. Less than or equal (<=)
d.  Equals (=)
e. Greater than or equal (>=)
f. Greater than (>) 

6． Transition to new stateを選択すると、プルダウンメニューでコンテンツを変更することができます。
7． Return to prior stateを選択すると、以前の状態に戻ります。
8． Remain on current stateを選択すると、インタラクティブが実行されても次のコンテンツに移動しません。
9． OKをクリックしConditional targetを保存します。
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User Variables

User Variableの値は変更することができます。 詳細はCHAPTER 8 Presentation Propertiesの変更をご参照ください。

1． メニューバーから、Tools > Setup BrightSign Unitを選択します。
2． Enable local web serverにチェックを入れます。
3． 必要に応じてWebサーバーのユーザー名とパスワードを入力します。
4． BrightSign Unit Setupの詳細はCHAPTER 2 Setting Up Unitsをご参照ください。
5． BirhgtSignのプレイヤーが起動プロセスを完了するのを確認します。
6． ウェブブラウザのアドレスバーに設定したアドレスを入力します。例えばBrightSignのIPアドレスを192.168.1.2と設定している場合
は、192.168.1.2:8008と入力します。

Web Browser
Webブラウザーを使用してUser Variableの表示および更新ができます。BrightSignのプレイヤーとPCを同じローカルネットワークに接
続している必要があります。

1． UDPイベントもしくはシリアルイベントを作成します
2． UDPイベントを編集するには入力フィードに<any>と入力します。シリアルイベントを使用している場合は<*>と入力します。
3． Advancedタブを選択しAssign input to variableにチェックを入れます。
a. BrightAuthorプレゼンテーションでSpecify fixed variableを使用する場合は、Specify fixed variableにチェックを入れます。UDP、
シリアル入力でUser Variableを編集するには<variable value>と入力する必要があります。
b. Input specifies variableを選択した場合は、UDP、シリアル入力でUser Variableの変更を指定します。UDP、シリアル入力では

<variable name> : <variable value>と入力する必要があります。
6． 設定を保存するにはOKをクリックします。

NOTE ： Input specifies variableを選択した場合は、単一のUDPイベントまたはシリアル入力イベントを使用して複数のUser Variables
を変更することができます。次のUDP、シリアル入力を使用します。<variable name> : <variable value> !! <variable name> : <variable 
value>

UDP or Serial Input Event
UDPまたはシリアルポートからの入力でUser Variableの値を変更することができます。
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説明イベントアイコン

静止画の表示時間を設定します。
Specify timeout (seconds) に任意の秒数を設定します。
＊表示する解像度・コンテンツによっては設定した時間で切り替らない場合があります。

ビデオファイル、オーディオファイルの再生が終わった後の次の動作を設定します。

GPIOボタンのインプット、アウトプットの設定をします。

オプション品のBP900やBP200のスイッチをトリガーとしたイベントを設定します。

複数のBrightSign間での同期を行います。

Timeout

Media End

GPIO Event

BP900/200

Synchronize

CHAPTER 5 インタラクティブイベント
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説明イベントアイコン

USBポートに接続された機器からの入力をトリガーとした動作を設定します。

ネットワークデバイスからの入力をトリガーとした動作を設定します。

シリアルポートに接続された機器からの入力をトリガーとした動作を設定します。

タッチスクリーンの指定したエリアをタッチした際の動作を設定します。

キーボードの指定したキーの入力をトリガーとした動作を設定します。

UDP Event

Serial Input

Rectangular Touch

Keyboard Input

USB Input
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説明イベントアイコン

ご利用いただくことができません。

Link Zone EventとSynchronize Eventを合わせて使用する際に使用します。

ディスプレイ内の別のゾーンとコンテンツの同期を行う際に設定します。

BrightAuthorで定義した領域に出入りするとトリガーとなり、コンテンツを切替えることが
できます。互換性のあるGPS USBデバイスを接続する必要があります。

Remote Input

Zone Message

Link Zones

GPS

ビデオ再生中の設定した時間にイベントを発生させます。

Video Time Code
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説明イベントアイコン

指定した日時、または定期的なスケジュールでコマンドを実行します。

Single date/time event
Dateのフィードに入力もしくは、カレンダー、プルダウンメニューから日時を設定します。

Daily timeout event
毎日、定期的に発生するイベントを設定します。
Dateのフィードに入力もしくは、カレンダー、プルダウンメニューから日時を設定します。

Time/Clock

User Defined Events

この機能は頻繁に使用するイベントを作成・保存することができます。

例えば5秒のTime outイベントを多用する場合に、User Defined Eventで5秒のTime outイベントを作成します。またUser Defined 
Eventは1つのイベントで複数のイベントを保存できます。1つのUser Defined EventでTime outやGPIOなどをミックスしたイベントを作
成することができます。

Media Libraryの下に表示されているuser eventsタブを選択します。次にManageボタンを選択します。
・ User Eventの作成 ： Add User Eventボタンをクリックします。User Eventウィンドウが表示されますので、任意のイベント
名を入力します。Add Eventボタンをクリックし、プルダウンメニューから使用するイベントを選択します。さらにイベントを追加
する場合は、Add Eventボタンをクリックします。イベントを追加すると表示秒数等を任意で決めることができます。
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・ User Eventの追加 ： Add User Eventボタンをクリックすると、User Eventを追加することができます。
・ User Eventの編集 ： 作成したイベントの左に矢印(↑↓)のマークが表示されます。矢印を選択することで、User Eventの入れ
替えができます。また矢印マークの隣に✕マークが表示されます。✕マークを押すと、User Eventを削除します。

・ User Eventの使用方法 ： Media Libraryの下に表示されているuser eventsタブを選択します。作成したUser eventsがすべて
表示されます。プレイリストのタイプをインタラクティブに変更し利用します。インタラクティブプレゼンテーションの設定方法に
ついては、CHAPTER 4 インタラクティブプレゼンテーションの作成 インタラクティブプレゼンテーションの作成をご参照ください。

BrightAuthorで作成したUser Eventはインポート/エクスポートすることができます。
File > import User Events/Export User Events からインポート/エクスポートします。
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CHAPTER 6 プレゼンテーションのPublish

BrightAuthorでプレゼンテーションを作成、保存した後に、BrightSignで表示するようにPublishする必要があります。
Publishする方法は4通りあります。

・ Local Storage ： SDカードに保存

・ BrightSign Network ： お問い合わせください。

・ Local Networking ： ローカルネットワーク上でプッシュ配信を行います

・ Simple File Networking ： ネットワーク更新

以下のセクションで各Publishについて説明します。

Local StorageでPublishすると、SDカード、USBフラッシュドライブ、または使用しているPCにプレゼンテーションファイルが保存されま
す。BrightSignアカウントは必要ありません。スケジュール設定されたプレゼンテーションを変更したい場合は、新たにプレゼンテーシ
ョンをPublishして、SDカードまたはUSBフラッシュドライブに新しいプレゼンテーションをコピーし、BrightSignに読み込ませます。
SDカードは常にBrightSignに接続しておく必要があります。
Local StorageでPublishするには、下記の手順で行います。

Publishing with Local Storage

1 プレゼンテーションファイルを保存します。File > Save… As
2 Publishタブへ移動します。

a 画面左上のPublishタブを選択します。

b Local Storageを選択します。

c Presentationsの下のBrowseを選択し、プレゼンテーションが保存されているフォルダーを選択します。



60

3 Publishするプレゼンテーションのスケジュールを作成します。

a 保存されているPresentationsのリストから、Presentationを選択します。

b Presentationをスケジュール欄にドラッグします。

c スケジュール欄をダブルクリックして、1日のスケジュールを設定します。

d スケジュール欄をダブルクリックすると、Schedule Presentationウィンドウが開きます。
ここではプレゼンテーションを再生する日時を調整します。

・ Presentation ： スケジュールを設定するプレゼンテーションを指定します。

・ Active all day, every day ： プレゼンテーションを24時間再生させる場合は、
このボックスにチェックを入れます。チェックを外すと以下の設定が可能なります。

・ Event time ： プレゼンテーションを再生させる時間を設定します。

・ Recurring Event ： 指定時間帯に繰り返し再生する場合は、このボックスに
チェックを入れます。

・ Recurrence pattern ： プレゼンテーションを再生する日を指定します。
毎日/平日/週末/の設定ができます。

・ Range of recurrence ： プレゼンテーションの再生を開始する日と終了する日を指定します。

e OKを選択するとスケジュール欄に設定した内容が反映されます。

f 他のプレゼンテーションを設定する場合は b - e の作業を繰り返します。
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4 Debugging、Log、Firmwareの設定。この項目は必要な場合のみ使用します。

a Debuggingを使用する場合はEnable serial debugging、Enable system log debuggingにチェックを入れます。

b Specify Loggingを選択すると、Loggingウィンドウが開きます。使用する項目にチェックを入れます。

c ファームウェアを更新する場合はSpecify Firmware Updateを選択します。Firmware Updateウィンドウが開きます。製品名
/Firmwareを確認しチェックを入れます。BrightAuthorを使用しているPCがインターネットに繋がっている必要があります。

5 Specify Passwordは、Brightsign Setup UnitでUSB Content Update Password (optional)の項目でパスワードを設定している場合
に、このボタンをクリックします。
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6 プレゼンテーションをPublishする。

a ストレージデバイス(SDカードまたはUSBフラッシュデバイス)をPCに接続します。

b Publish toの下のBrowseから保存先を設定します。

c USBフラッシュデバイスを使用してBrighSignに接続されたSDカードの内容を更新する場合は、Publish for USB upgradeにチェッ
クを入れます。

d Publishをクリックします。Completeウィンドウが表示されたらOKをクリックします。

Simple File NetworkingでPublishを選択すると、ネットワーク経由でコンテンツを更新することができます。BrightSignは指定されたWeb
フォルダーを定期的に確認し更新します。
＊初めにBrightSignにコンテンツを確認させるWebフォルダーのURLを設定する必要があります。詳細についてはCAPTER 2 Setting 
Up Units Simple File Networkの設定をご参照ください。

Publishing with Simple File Networking

1 プレゼンテーションファイルを保存します。File > Save… As.
2 Publishタブへ移動します。

a 画面左上のPublishタブを選択します。

b Simple File Networkを選択します。

c Presentationsの下のBrowseを選択し、プレゼンテーションが保存されているフォルダーを選択します。

3 Publishするプレゼンテーションのスケジュールを作成します。

a 保存されているPresentationsのリストから、Presentationを選択します。

b Presentationをスケジュール欄にドラッグします。

c スケジュール欄をダブルクリックして、1日のスケジュールを設定します。
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d スケジュール欄をダブルクリックすると、Schedule Presentationウィンドウが開きます。
ここではプレゼンテーションを再生する日時を設定します。

・ Presentation ： スケジュールを設定するプレゼンテーションを指定します。

・ Active all day, every day ： プレゼンテーションを24時間再生させる場合は、
このボックスにチェックを入れます。チェックを外すと以下の設定が可能になります。

・ Event time ： プレゼンテーションを再生させる時間を設定します。

・ Recurring Event ： 指定時間帯に繰り返し再生する場合は、このボックスに
チェックを入れます。

・ Recurrence pattern ： プレゼンテーションを再生する日を指定します。
毎日/平日/週末/の設定ができます。

・ Range of recurrence ：プレゼンテーションの再生を開始する日と終了する日を指定します。
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e OKを選択するとスケジュール欄に設定した内容が反映されます。

f 他のプレゼンテーションを設定する場合は b - e の作業を繰り返します。

4 Debugging、Log、Firmwareの設定。この項目は必要な場合のみ使用します。

a Debuggingを使用する場合はEnable serial debugging、Enable system log debuggingにチェックを入れます。

b ファームウェアを更新する場合はSpecify Firmware Updateを選択します。Firmware Updateウィンドウが開きます。製品名
/Firmwareを確認しチェックを入れます。BrightAuthorを使用しているPCがインターネットに繋がっている必要があります。

5 プレゼンテーションをPublishする。
a Simple File Networking Parametersの下のSet Parametersを選択します。

b Simple File Networking Parametersウィンドウが開きます。
・ Unit Configuration ： WebフォルダーのURLを入力/確認します。

WebフォルダーのURLはSetup BrightSign unitで設定したURLと同一である必要があります。

・ Content Check Frequency ： サーバーに確認する頻度を設定します。

・ Limit content downloads ： 指定した時間にコンテンツをダウンロードするときには、この項目を設定します。

c Loggingを設定する場合のみ、この項目にチェックを入れます。
・ Enable Playback logging ： Playlistが使用された際にログを作成します。

・ Enable event logging ： イベントが使用された際にログを作成します。
・ Enable State logging ： 現在と最後のstate names 、timestampsやmediaタイプのログを作成します。

・ Enable diagnostic logging ： timestamps、firmware、Scriptバージョンや現在のプレゼンテーション
のログを作成します。
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d Upload logsの下の設定では、サーバーにログをアップデートするタイミングを設定します。
・ On startup ： BrightSignが起動する度に、ログを作成します。
・ At specific time each day ： 指定された時間に毎日ファイルを作成します。

e OKをクリックします。

f Publish toの下のBrowseから保存先を設定します。
・ Webフォルダーにファイルを転送する場合は、お使いのPC上のフォルダーにPublishしFTPソフトウェアを使用してアップロー
ドする必要があります。

g Publishをクリックします。Completeウィンドウが表示されたらOKをクリックします。
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Local NetworkでPublishを選択すると、ローカルネットワーク経由で直接BrightSign本体にプレゼンテーションをPublishすることができ
ます。Webサーバーを必要とせずに、BrightAuthorを使用しているPCとBrightSignがローカルネットワークで繋がっていれば、簡単に
プレゼンテーションを変更することができます。

＊BrightAuthorの初期設定では、Local Networkのタブが表示されません。
メニューバーから、Edit > Preferences ＞ Networking ＞ Enable BrightSign Local Networking にチェックを入れます。
＊初めにBrightSignにIPアドレスを設定する必要があります。詳細についてはCAPTER 2 Setting Up Units Local Networkの設定をご
参照ください。

Publishing with Local Networking
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1 プレゼンテーションファイルを保存します。File > Save… As.
2 Publishタブへ移動します。

a 画面左上のPublishタブを選択します。

b Local Networkを選択します。

c Presentationsの下のBrowseを選択し、プレゼンテーションが保存されているフォルダーを選択します。

3 Publishするプレゼンテーションのスケジュールを作成します。

a 保存されているPresentationsのリストから、Presentationを選択します。

b Presentationをスケジュール欄にドラッグします。

c スケジュール欄をダブルクリックして、1日のスケジュールを調整します。

d スケジュール欄をダブルクリックすると、Schedule Presentationウィンドウが開きます。
ここではプレゼンテーションを再生する日時を設定します。

・ Presentation ： スケジュールを設定するプレゼンテーションを指定します。

・ Active all day, every day ： プレゼンテーションを24時間再生させる場合は、
このボックスにチェックを入れます。チェックを外すと以下の設定が可能になります。

・ Event time ： プレゼンテーションを再生させる時間を設定します。

・ Recurring Event ： 指定時間帯に繰り返し再生する場合は、このボックスに
チェックを入れます。

・ Recurrence pattern ： プレゼンテーションを再生する日を指定します。
毎日/平日/週末/の設定ができます。

・ Range of recurrence ：プレゼンテーションの再生を開始する日と終了する日を指定します。

e OKを選択するとスケジュール欄に設定した内容が反映されます。

f 他のプレゼンテーションを設定する場合は b - e の作業を繰り返します。

4 Debugging、Log、Firmwareの設定。この項目は必要な場合のみ使用します。

a Debuggingを使用する場合はEnable serial debugging、Enable system log debuggingにチェックを入れます。

b ファームウェアを更新する場合はSpecify Firmware Updateを選択します。Firmware Updateウィンドウが開きます。製品名
/Firmwareを確認しチェックを入れます。BrightAuthorを使用しているPCがインターネットに繋がっている必要があります。
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5 プレゼンテーションをPublishする。

a Publishの下の項目でPublish先を選択します。

・ 新しいBrightSignを追加するには、New unitを選択します。 ボタンをクリックするとAdd BrightSign Unitウィンドウが開き
ます。追加するBrightSignのIPアドレスを入力し、OKをクリックします。

・ すでにBrightSignが追加されている場合は、Networked unitを選択しリストからPublishする端末を選びます。 ボタンをク
リックするとリストが更新されます。

d Publishをクリックします。Completeウィンドウが表示されたらOKをクリックします。
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CHAPTER 7 プレゼンテーションのカスタマイズ

この章ではプレゼンテーションのカスタム方法について説明します。

Zone Propertiesの設定

1 プレゼンテーションファイルを選択します。 File > Open Presentation
2 プレイリストのグループにあるEditダブを選択します。
3 画面左上にあるZoneの下から設定したいエリアをクリックします。
4 Zone Propertiesをクリックします。Edit Zoneウィンドウが開きます。

HD110、HD210、HD410、HD810、HD1010

・ View Mode ： プルダウンメニューからVideoの設定を行います。

・ Scale to Fill ： アスペクト比を維持せずに、画面全体に引き伸ばします。

・ Letterboxed and Centered ： アスペクト比を維持して中央に表示します。

・ Fill Screen and Centered ： アスペクト比を維持して中央に表示します。はみ出した領域はカットされます。

・ Audio settings ： プルダウンメニューからAudioの設定を行います。

・ Image Mode ： プルダウンメニューからImageの設定を行います。
・ Center Image ： スケーリングせずに、中央に表示します。

・ Scale to Fit ： アスペクト比を維持し、ゾーンに合わせて最大化表示します。

・ Scale to Fill and Crop ： アスペクト比を維持して中央に表示します。はみ出した領域はカット
されます。

・ Scale to Fill ： アスペクト比を維持せずに、ゾーンに合わせて表示します。

Video Only、Video or Imagesの編集

ゾーンの設定をカスタマイズすることができます。

このウィンドウに表示される設定は、使用しているBrightSignプレイヤーのモデルによって異なります。
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HD120、HD220、HD1020、XD230

・ View Mode ： プルダウンメニューからVideoの設定を行います。

・ Scale to Fill ： アスペクト比を維持せずに、画面全体に引き伸ばします。

・ Letterboxed and Centered ： アスペクト比を維持して中央に表示します。

・ Fill Screen and Centered ： アスペクト比を維持して中央に表示します。はみ出した領域はカットされます。

・ Audio Output ： 出力するオーディオのタイプを選択します。

・ Pass through ： オーディオを外部機器でデコードする場合は、このオプションを使用します。

・ Stereo ： HDMIを介してデコードされた音声信号を出力します。

・ Audio Mixing ：出力する音声の出力方法を設定します。

・ Image Mode ： プルダウンメニューからImageの設定を行います。

・ Center Image ： スケーリングせずに、中央に表示します。

・ Scale to Fit ： アスペクト比を維持し、ゾーンに合わせて最大化表示します。

・ Scale to Fill and Crop ： アスペクト比を維持して中央に表示します。はみ出した領域はカットされます。

・ Scale to Fill ： アスペクト比を維持せずに、ゾーンに合わせて表示します。

・ Initial Volume (Video) ：ビデオファイルのボリュームの初期値を設定（0-100）します。

・ Initial Volume (Audio) ：オーディオファイルのボリュームの初期値を設定（0-100）します。

・ Initial Volume (Video) ：ビデオファイルのボリュームの初期値を設定（0-100）します。

・ Initial Volume (Audio) ：オーディオファイルのボリュームの初期値を設定（0-100）します。

・ Live Video ：BrightSignオプション製品のLive Video moduleを使用する際に設定します。

XD1030、XD1230

・ View Mode ： プルダウンメニューからVideoの設定を行います。

・ Scale to Fill ： アスペクト比を維持せずに、画面全体に引き伸ばします。

・ Letterboxed and Centered ： アスペクト比を維持して中央に表示します。

・ Fill Screen and Centered ： アスペクト比を維持して中央に表示します。はみ出した領域はカットされます。

・ Audio Output ： 出力するオーディオのタイプを選択します。



71

・ Pass through ： オーディオを外部機器でデコードする場合は、このオプションを使用します。

・ Stereo ： HDMIを介してデコードされた音声信号を出力します。

・ Audio Mixing ：出力する音声の出力方法を設定します。

・ Image Mode ： プルダウンメニューからImageの設定を行います。

・ Center Image ： スケーリングせずに、中央に表示します。

・ Scale to Fit ： アスペクト比を維持し、ゾーンに合わせて最大化表示します。

・ Scale to Fill and Crop ： アスペクト比を維持して中央に表示します。はみ出した領域はカットされます。

・ Scale to Fill ： アスペクト比を維持せずに、ゾーンに合わせて表示します。

・ Initial Volume (Video) ：ビデオファイルのボリュームの初期値を設定（0-100）します。

・ Initial Volume (Audio) ：オーディオファイルのボリュームの初期値を設定（0-100）します。

Ticker Zoneの編集

Number of Lines ：Ticker zoneの表示行数を指定します。

Time to Display Each Line ：Tickerを表示させる秒数を指定します。

Rotation ： Tickerを回転（0°、 90°、180°、270°）して表示させます。

Alignment ：Tickerの表示位置を設定します。

Text Appearance ：Tickerの表示方法を設定します。

・ Animated ： アニメーション表示
・ Static Text ： 一斉表示

Foreground Text Color ： Tickerの文字色を変更。

Background Text Color ：Tickerの背景色を変更。

Transparency ： 透過率を変更。

Font ： 文字のフォントを選択します。日本語を表示する場合は、予めフォントを用意しておく必要があります。

Advanced ： Advancedを選択すると次のオプションが選択できます。

・ Background bitmap ： この項目を設定すると、テキストの背景にBackground Imageを設定することができます。
・ Safe Text Region ： Tickerの表示位置の調整を行うことができます。
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その他のZoneの編集

・ Images zone ： イメージモードの設定。

・ Audio Only zone ：オーディオの設定。

・ Clock zone ：回転、テキストの文字色、背景、透過率の設定。

・ Background Image zone ：選択することができません。Backgroundの背景色を変更する場合は、Presentation Propertiesで変更
できます。

・ Enhanced Audio zone ：オーディオの設定。

Edit Zoneウィンドウの設定は選択したゾーンのタイプによって異なります。

レイアウトのカスタマイズ

1 新しいプレゼンテーションファイルを作成します。File > New Presentation 

2 Editタブの下にあるLayoutを選択します。

・ プレビュー画面内のゾーンをクリックして、選択したゾーンのサイズを直接変更します。また画面左側のSizeに数値を入力
することで、幅、高さの設定もできます。

・ ゾーンをクリックして目的の位置にドラッグし、ゾーンの位置を変更します。また画面左側のPositionに数値を入力すること
で、表示位置の設定もできます。

BrightAuthorのプリセットのレイアウト以外に、自由にレイアウトを変更することができます。
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・ ゾーンを追加するにはAdd zoneボタンをクリックします。New Zoneウィンドウが表示されますので、Zone nameを入力し、
Zone Typeを選択しOKをクリックします。

・ Ctrl＋Clickを選択すると2つ以上のゾーンを指定できます。メニューバーのFormat > Make same sizeでゾーンのサイズ変
更ができます。

・ Ctrl＋Clickを選択すると2つ以上のゾーンを指定できます。メニューバーのFormat > Alignでゾーンの整列を行えます。

・ メニューバーのFormat > Center in formから、選択したゾーンをプレイリストの中央に配置することができます。

3 画面左下にあるSave Templatesをクリックし、作成したTemplateを保存します。

4 新しく作成するプレゼンテーションでカスタマイズしたTemplateを使用するには、Templateウィンドウで画面右上にあるViewより
User Defined Templatesを選択し、カスタマイズしたTemplateを選択します。
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Preferenceの変更

作成するプレゼンテーションはEdit Preferencesの設定に基づいています。頻繁に同じ設定を繰り返し使用する場合は、
Edit Preferencesを変更するとスムーズに作業ができます。

1 メニューバーからEdit > Preferences

2 VideoタブをクリックしVideoの設定をします。

・ Volume ： ボリュームを設定します。

・ Live video – time on screen ： Live videoを表示する時間を設定します。
3 Imagesタブをクリックし静止画の設定をします。

・ Slide Transition ： 静止画のエフェクトを選択します。

・ Slide delay interval ： 静止画を切替える間隔を設定します。

4 InteractiveタブをクリックするとInteractive event時の静止画を切替える間隔を設定することができます。

5 Clockタブをクリックすると表示言語の変更ができます。

6 Live Textタブをクリックすると表示方法の変更ができます。

・ Alignment ：Tickerの表示位置を設定します。

・ Foreground Text Color ： Tickerの文字色を変更。

・ Background Text Color ：Tickerの背景色を変更。

・ Transparency ： 透過率を変更。

・ Font ： 文字のフォントを選択します。日本語を表示する場合は、予めフォントを用意しておく必要があります。

・ Font Size ： 文字のフォントサイズを自動設定、またはサイズ指定します。

7 NetworkingタブをクリックするとPublishタブで表示するネットワークを選択できます。Local Networkingはデフォルトではオフにな
っています。

8 UIタブをクリックするとインタラクティブ時のラベルの設定、設定変更後のダイアログ表示の設定ができます。

9 設定終了後OKをクリックします。
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Main
Mainタブの設定。
・ Connector type ： 接続するディスプレイのタイプをプルダウンメニューから選択します。（VGA、HDMI、Component）

・ Screen resolution ： 表示解像度をプルダウンメニューから選択します。

・ Background screen color ： 背景色の設定を行います。

・ Language ： 表示言語を選択します。

CHAPTER 8 Presentation Propertiesの編集

この章ではプレゼンテーション全体のプロパティを編集することができます。デフォルトの設定を変更するにはPreferencesの変更をご
参照ください。メニューバーからFile > Presentation Propertiesを選択します。

I/O
I/Oタブの設定。I/OタブをクリックするとGPIOのInput、Outputの設定をすることができます。

Interactive
シリアルポートなどの設定を行います。

・ Serial ： シリアルポートの通信設定。Invert Signalsにチェックを入れると、送受信ピンを反転し受けることができます。
・ UDP ： UDPの設定。
・ Touch ： カーソルの表示非表示の設定を行います。Flip coordinatesはタッチスクリーンの座標が反転している場合のみ、
このオプションにチェックを入れます。

Always hide cursor ： カーソルを常に非表示
Always display Cursor ： カーソルを常に表示
Auto display cursor ： タッチ領域を設定した場合のみ、カーソルを表示
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Buttons
オプション製品のBP900/BP200の設定を行うことができます。

Audio
音声のボリュームの設定をします。
・ Audio Minimum and Maximum Volume (0 – 100)
・ HDMI Minimum and Maximum Volume (0 – 100)

Media List
・ Return to start after inactivity ： Yesにチェックを入れると、Media Listでインタラクティブの信号が入力されなければ、指
定した時間にMedia Listの先頭に戻ります。

・ Inactivity timeout (seconds) ： Media Listの先頭に戻る時間を設定します。

Autorun
Standard AutorunファイルもしくはSelect custom Autorunファイルを選択できます。

Image Cache
Imageファイルをキャッシュに保存することができます。キャッシュに保存することで、読み出しが早くなります。

Variables
Device Webページ、Media Countersの表示の有効、変数の作成を行います。
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Device Web Page Display
Device Web Page Displayはローカルネットワーク経由でUser Variablesの表示や編集をすることができます。
・ No device web page ： Device Web Pageへアクセスできないように設定します。
・ Standard device web page ： デフォルトで設定されているDevice Web pageを表示します。
・ Custom device web page ： この項目ではカスタムされたdevice web pageを表示できます。Custom device web pageにつき

ましてはhttp://support.brightsign.biz/homeにあります、Creating a Custom Device Web Pageを参照ください。

Media Counters
Media Counterでは、プレゼンテーションのファイルを再生した回数が記録/表示されます。Media Counterはファイルの再生回数を
ライブテキストで表示したり、USB経由でBrightSignから抽出することができます。Automatically create media counter variablesに
チェックを入れない場合、Media Counterは表示されません。USB経由で記録したMedia Counterを取得する方法の詳細につきま
しては、Using advanced toolsをご参照ください。

User Variables
User Variablesはコマンドとして使用するかLive Textとしてディスプレイに表示することができます。Live Textとして使用する場合は
現在の値を表示します。この値は継続的にプレゼンテーション中に変更することができます。この値はSet VariableやReset 
Variableを使用して変更できます。

Integrating User Variables with Commands
User variablesは以下のコマンドで使用することができます：
Set Volume, Increment Volume, Decrement Volume, Send UDP, Serial-send string (EOL), Serial-send string (no EOL), Serial-
send byte, Serial-send bytes (comma separated), Synchronize, Send Zone Message, Link Zones, GPIO On, GPIO Off, GPIO Set 
State, BrightControl – Send Ascii String, BrightControl – Philips Set Volume, Pause. 

例えばプレゼンテーションにSet Volumeコマンドを追加し、ボリュームを50と設定します。コマンドが発生した際にボリュー ムは常
に50に設定されます。User variableを使用する場合、ボリュームは設定したVariableコマンドに基いて任意の値やその他の要因の
任意の数に設定されます。
User Variablesを利用するにはまずコマンドを追加します。 Parameters fieldでは2つの$記号（$$）でくくる必要があります。例え
ば、$$variable1$$と入力します。BrightAuthorは$記号なしではVariablesを認識しません。
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Adding User Variables
・ Name ： 任意の名前を入力します。
・ Default Value ： 設定するUser Variableのデフォルト値を入力します。User Variableはリセットされるたびにデフォルト値に戻り
ます。
・ Networked ： Data Feed経由で更新を可能にする場合にチェックを入れます。
・ Type ： User Variableには3つのタイプがあります。
・ Local ： Set VariableやReset Variableコマンドをローカルネットワークを経由して変更することができます。適切にフォーマ
ットされたシリアルコマンドとUDPコマンドで設定することができます。
・ Networked ： VariablesをData Feeds（RSS、Live Data or Dynamic Playlist)を使用して変更します。ネットワーク接続された
User Variablesを作成するには最初にData Feedを指定する必要があります。プルダウンメニューからData Feedを選択しリ
ンクが正しいか確認をするためにValidateをクリックします。
Note ： すべてのRSSフィードには<title>と<description>タグがあります。変更するUser Variablesの名前を<title>タグを使用
して指定します。User Variablesの値を変更するには<description>タグを使用します。
・ System ： シリアルナンバーやファームウェアのバージョンなどをBrightSignに接続しているディスプレイに表示することがで
きます。

Date Feeds
Live TextやRSSなどを作成するときに使用します。Add Date Feedをクリックし追加します。
・ Feed name ：名前を入力します。Live Text、RSS、Networked User Variablesを作成していると、入力した名前でデータフィ
ードを見つけることができます。
・ Url ： RSSフィードのWebアドレスを入力します。
・ Live Data Feed ： BrightSign Networkアカウント（有料サービス）を使用すれば、簡単にBrightSignネットワーク・サーバーに
RSSフィードを公開することができます。
・ Dynamic Playlist ： BrightSign Networkアカウント（有料サービス）が必要です。 データフィードなどのDynamic Playlistを使
用できます。
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・ Refresh ： Dynamic PlaylistまたはBrightSign Networkを使用してLive Text Feedの作成、変更した場合にLive Data Feed
またはDynamic Playlist内のコンテンツを更新できます。

・ Validate ： Urlに入力したWebアドレスにPingを実行するには、このボタンをクリックします。

・ Update Interval ： コンテンツの更新頻度を設定します。

・ Plugin Script/Parser Function Name ： 高度な設定項目です。BrightSign Scriptの編集が必要になります。ご利用の場合
は、サポートまでお問い合わせください。

HTML Sites
HTMLサイトをプレゼンテーションに追加するには、このタブを使用します。Add HTML Siteをクリックし指定します。
・ HTML site name ：登録するHTMLサイトの名前を入力します。
・ Local Content ： コンピュータのローカルストレージ上にあるHTMLファイルを表示する場合は、この項目を選択します。
Browseからファイルを指定します。
・ URL ： 表示するHTMLサイトのアドレスを入力します。

NOTE ： BrightSign XDプレイヤーは汎用のWebブラウザーとして使用するようには設計されていません。多くのWebページには
BrightSign XDシリーズで正しく表示できない要素があります。サイネージとして利用する場合は事前に実機での検証が必要で
す。HTML5の詳細につきましては、 http://support.brightsign.biz/homeにありますHTML5 Best Practicesをご参照ください。

Switch Presentations
複数のプレゼンテーションを登録して、SDカードに保存されているプレゼンテーションを切り替えることができます。bpfファイルを
登録しSwitch to Presentationコマンドで切り替えます。

Files
プレゼンテーションと一緒にSDカードに追加のファイルをPublishする場合はこのタブを使用します。プレゼンテーションで使用され
ていないファイルを頻繁にPublishするとき（例えば、カスタムスクリプトによって利用されているメディアファイル）や、プレ
ゼンテーションファイルとカスタムファイルを自動的にPublishするときに便利です。
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Using Advanced Tools

Advanced toolsを使用するとBrightSignを制御したり、デバイスのデータを取得することができます。USBフラッシュドライ
ブをセットアップした後、BrightSignに接続すると指定したデータを抽出したり、指定されたアクション （再起動など）を実
行します。

USBフラッシュドライブのセットアップ

1 メニューバーからTools > Advancedを選択

2 Setup USB Driveタブ ：

3 BrightSign本体にUSBフラッシュドライブを接続した際に発生するアクションを設定します。

・ Copy variables database ： User variablesとMedia Countersを抽出します。

・ Copy log files ： すべてのログファイルを抽出します。

・ Delete log files ： すべてのログファイルを削除します。

・ Reset Variables ： User Variablesをリセットします。

・ Reboot ： BrightSignを再起動させます。

・ Display status on screen during data capture ： 画面上に上記ステータス終了の案内が表示されます。

4 Setup driveをクリックし、USBフラッシュドライブの場所を指定します。

5 PCからUSBフラッシュデバイスを取り外し、BrightSignに接続します。

6 Update Autorun/Unit Controlタブ ：BrightSign Networkアカウントが必要です。
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これまでに紹介した機能を使用することで、様々な方法で簡単にサイネージを構築することができます。
ここでは各機能を使用した活用事例を紹介します。

FULL HD PLUS 3D

Full HD Videoの再生や3Dコンテンツを再生することができます。
HDMIで出力することで最大1080pで表示することができます。また3Dコンテンツをサポートしており、side-by-side またはtop-over-bottomを
サポートしています。

ZONES

分割した各画面をゾーンと呼び、ゾーンごとに異なるコンテンツを再生させることができます。
動画、静止画、テキストなどの複数のデータを分割した画面に同時に表示でき、レイアウトは自由にカスタマイズすることができます。

活用事例

CHAPTER 9 活用事例
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VIDEO WALL SYNCHRONIZATION

複数のBrightSign間をLANケーブルで接続して、再生を同期化し複数のモニターの映像が繋がった一つの映像であるように表示することが
できます。2台のBrightSignを接続する場合はLANケーブルで直接接続し、3台以上接続する場合はHubを使用して接続します。
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TOUCH SCREEN

タッチスクリーン、USBマウスなどで指定されたエリアをタッチまたはクリックすることでコンテンツを切り替えることができます。

INTERACTIVITY

GPIO、RS-232C、キーボード、マウスなどBrightSignは様々なデバイスと接続することができます。外部からの信号をトリガーとして、コンテン
ツを切り替えることができます。
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UDP CONTROLS

UDPをトリガーとしたインタラクティブを使用すると、iPAD等を使って離れた場所からコンテンツの切り替えを行うことができます。

LIVE TEXT

LIVE TEXT機能を使用すると、リアルタイムにプレゼンテーションの変更を行うことができます。メニューボードやインフォメーションボードなど
に非常に適した機能です。

Menu board pricing Waitlist display Transportation and event 
schedule
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RSS AND SOCIAL MEDIA FEEDS

RSSやTwitter Feedを表示することができます。

Headline news and weather Stock prices and financial rates Twitter feeds

NETWORKING

BrightSignをネットワークに接続することで、ネットワーク経由でコンテンツを簡単に更新できます。BrightSignは3通りのネットワーク更新の方
法を提供します。ネットワーク機能を使用するとコンテンツの更新以外に、RSSフィードやTwitterなどの情報を表示できます。
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Simple File Networking機能はWebサーバーをお客様で別途準備する必要があります。Webフォルダー内の情報を定期的に確認します。

BrightSignネットワークソリューション

ローカルネットワーク経由で直接BrightSign本体にプレゼンテーションをPublishすることができます。Webサーバーを必要とせずに、
BrightAuthorを使用しているPCとBrightSignがローカルネットワークで繋がっていれば、簡単にプレゼンテーションを変更することがで
きます。

BrightSign Networkは有料のサービスです。サーバーはBrightSign社が提供しており、リアルタイムで端末の確認ができます。
BrightSign Networkをご利用になる場合は、お問い合せください。
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CHAPTER 10 FAQ

この章ではよくお問合せいただく内容を紹介します。

画面が表示されない。

BrightSignのファームウェアを最新にアップデートしてください。

Errランプが点灯する。

BrightSignにSDカードが接続されているか確認してください。SDカードが接続されていないとErrランプが点灯します。

作成したプレゼンテーションが表示されない。

プレゼンテーションのConnector type、Screen resolution が正しく設定されているか確認してください。

表示コンテンツの切り替えが遅い。

静止画は画面解像度と同じ解像度でない場合、BrightSignでスケーリングするために表示が遅くなります。静止画を画面解像度に
合わせて作成してください。

Media LibraryにMPEGファイルが表示されない。

BrightAuthorで扱える拡張子は .TS, .MPG, .VOB, MOV, MP4, WMVになります。 例えば.MPEGでは表示されません。

動画ファイルが表示されない。

BrightSignで対応していないフォーマットで作成されている可能性があります。対応フォーマット、コーデックにつきましては、
CHAPTER 1 はじめに Step 4：BrightAuthorのサポートコンテンツをご参照ください。

音声が出力されない。

CHAPTER 7 プレゼンテーションのカスタマイズのAudio settingsの設定を確認してください。
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CHAPTER 11 さらに使いこなすために

BrightSignの機能を十分にご利用いただくには、最新のソフトウェア、ドキュメントをご利用ください。また、各種デモンスト
レーション用コンテンツが用意されていますので、併せてご利用ください。

・ サポート： 最新のユーザーガイド、リリースノート、ハードウェアマニュアルは、次のアドレスをご覧下さい。最新のBrightSignのソ
フトウェア、BrightAuthor、各種スクリプト、製品に関する技術情報を公開しています。

http://support.brightsign.biz/home

・ デモ コンテンツ： ループ再生、インタラクティブ、同期再生等、各種のデモンストレーションを ご利用いただくことができます。

http://www.brightsign.biz/demos/hd/

・ Japan Material GS部サポートサイト ： 製品に関する、よくある質問と答え(FAQ)や、詳細な技術情報を掲載しています。

http://jmgs-support.jp/

・ お問い合せ先 ： 製品に関するお問合せは、製品に同梱の保証書に記載のサポートセ ンターへお問い合せください。

ジャパンマテリアル株式会社
グラフィックスソリューション事業部
〒169-0073
東京都新宿区百人町2-4-8ステアーズビル７F
TEL：03-5338-2701 FAX：03-5338-2710
www.jmgs.jp
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